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An open introduction!

The minimum good will and self-esteem required
Dear fellow enthusiasts, even the newest of beginners amongst us,

If you are sufficiently patient, this guide will help you unleash the power of Linux, in a
Multimedia Centre of Ferrari 500 HD quality, using Power Board’'s Enigma2 Operating
System (from now on referred to only as MMC, F500HD, PB, E2 and OS, respectively)lll

Do not trust anyone who keeps telling you that Linux is not for everybody! Believe in
yourselves! For crying out loud, if I can - anyone can! I am not from “technical/IT
and/or natural sciences” but from “humanities”, so I have no idea “what's really going on
‘behind the scene’, in the code itself”! Moreover, I couldn't code or “hack” anything even
if my very life depended on it and therefore do a bit of this before you start...

Guaranteed. ..

...if you persevere, within hours, provided one follows this "little manual” of mine, with loadsa
pretty pickies, it will all work well in the end, given the absence of spiritual laziness...

If one either doesn't know how to dispel self-doubts or if one is being all ‘majestically
princely’, i.e. if one "just can't be bothered”, that is to say, if one “only wants it all working" -
but without any effort!ll - one is bound to be "disappointed”! At least well out of pocket,
paying the professionals to do it for one, as this just won't set itself up nicely...

I know only of persistence and doggedness. Then and only then "the magic” happens. Only
then can one really enjoy one's new toy, after "working on it", and learning about its “ins and



outs"lll EVERYBODY, women and children, technophobes and luddites included, can learn
about it and enjoy it - easily! I will make sure it happens by the end of this "guide”, hehelll

This will not be an exhaustive, comprehensive “how to"!

This "little” guide will only be an example of PBNIGMA II VX in F500HD, since I cannot
cover properly various features of FBOOHD SE or 8000 models, like WLAN, built-in HDD,
twin tuners etc. Besides, new drivers, new Images, new plug-ins etc. are being written and re-
written constantly... So, the hobby keeps evolving and being interesting!

In addition, I only have one original card, so some issues with card server part of Card
Sharing (in future text "CS"), I cannot fully test and report. At best, I can only read and give
other people's account of it all, maybe with some of their examples included in the text.

However, all the other crucial things (and a "bit" more, heh) will be here, described in
detail, in a careful step-by-step manner, so everybody, with minimum patience, self-
confidence and intelligence, can sort it out for themselves. Given some time to read - and
a bit of necessary concentration - you will be able to do it, aided every step of the way, even
regarding the basics of PC applications, with plenty of examples and graphics!!!

Nevertheless, I must warn you, once again, at the very outset, to do it properly, please -
EVERY step of the way, without "cutting corners” - so you familiarise yourselves thoroughly
with all sorts of possibilities within E2!

And there is a lot of it awaiting! A shitload of plugins, skins, emus, tools and whatnot (which
can satisfy just about anybody's specific need), is "out there”, so this can't be a total but
always partial guide to E2 in F500 HD or any MMC, for that matter!

Still, T'll try giving it a good go, to describe how to fully use most of E2's capabilities, bar
some HW limitations that I face with the models I have, as I said... By the time we're
finished here - if you follow it properly - you will come pretty close to fully enjoying it all!

Register here, get the SW, learn and contribute, if you can

If one needs more info on a specific issue or a piece of FW, visit various good forums, like...

http://www.pb-powerboard.com/board/index.php? - in German and English: get a PBNIGMA
IT VX image you want, primarily here - and give feedback to the worthy authors, of coursel!

http://www.8a8f8.com/ - Ferrari boxes, in English and German

http://www.sat-universe.com/ - English and many other language sections

http://www.satforum.me/index.php - Serbo-Croat/Croato-Serbian, English and German

By the way, this guide will also work in original Dreamboxes, but - thanx to HW differences,
as I will explain later on (thanx to the specificities of FBOOHD and advantages over
DB500HD) - with some reduced functionality (unless you buy more HW)...


http://www.pb-powerboard.com/board/index.php
http://www.8a8f8.com/
http://www.sat-universe.com/
http://www.satforum.me/index.php
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el B e V- T e

Your trial period is over || i
Please registrer | |

to continue using |
this software!
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1) Failing to prepare is preparing to faill
SW and HW preparation

Before I begin, let me say that not everything can be explained in a strictly tfemporal, logical
manner, as if you are actually doing it - but I'll try anyway... SW preparation part first!

For newbies, who just got their Multimedia Centre:

One should search the internet, download and install on one's PC (the apps are freeware!)
-UNIX compatible editor, like Notepad++ (do not edit your files with Notepad, Word/ -Paa)
-FileZilla Client (FZC from now on), to connect (FTP) with your box

-7zip, to decompress compressed files ("unpack/extract" them to your PC)

-PuTTY, for Telnet commands - for advanced users

-DB Edit and maybe DreamSet Editor to edit and download/upload your channel list
-Easeus Partition Master Home application - erase/create partitions on your USB devices

For veterans (if you already have E2 installed), backup E2 files to your PC/laptop:

-backup your channel list, using DB Edit, if you already had your settings sorted out in this
regard - and don't forget to save your /etc/enigma2/settings file, also!

-backup your EMU(s), just in case, using FZC or depending on an Image, “internally”

Various configuration files for PB-E2 VX are in:

/etc folder [for CCcam] and

/etc/tuxbox/config [for OSCam] folders,

modules are in /usr/bin/emu folder, plus

scripts, to start and stop an Emu from CAMD Manager, are in /usr/script/emu folder.

For F500HD download these application to flash your receiver:

-FerrariFiller_1_3_3_7F or
-FlashWizardPRO or just use a
-Web Browser via (W)LAN Home Network (FireFox is OK, IE can do it, Chromium, also).

For expanding your receiver's "flash”/memory_ limitations and/or multiboot purposes:
-USB memory sticks of at least 256 MB (for Flash Expander) - prepare a few, since not all
might be compatible with your machine, ergo the more, the merrier, just in case...

We need to format a few of them, since sometimes USB sticks are a bit temperamental and
might not work (very well) with your machine...

Easeus Partition Master Home Edition, which is free for personal use, will do the job nicely,
if you need to format your USB HDD, too. This is what I will do, later on, in this installation!

Plug one into your PC/laptop and then start the application. You will see something like this:
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The bottom one is the USB stick (Disk2). Right click on it - Delete Partition. Right click >
Create partition; make it a >Primary partition >File System called EXT3 (or better EXT2?).

I would advise you to get a larger capacity USB memory stick of small dimensions (as
technology generally tends to, they are getting ever cheaper and smaller - see Deal Extreme
website, for instance), especially if you are going to use it for Timeshift function.

If you do get a greater capacity USB stick, make two (2) partitions on it:

0) for Flash Expander (500 MB is enough for all our purposes, 1GB is even better) and

1) to direct EPG, picons, subtitles etc. to it (the rest of your USB stick).

Then, click on "Apply”, in the left upper corner and confirm. Wait. (See the image above.)

F500 HD has only one external USB port, so if you are going to use a USB HDD external
drive, you will simply need to plug in the stick internally. Worry not, I will explain it all below,
in detail, so any tfechnophobe can do it easily and without stress!!!

As far as HDD is concerned, format it into EXT3 (or EXT2?), using the app mentioned, on
your PC. It's faster like that, than formatting it by using F500 HD/PBNIGMA II VX! Large
HDD formatting by F500HD E2 could last forever and of course, PC is more capable...



Btw, don't bitch: original DB has no external USB port! ©

On top of that, one can connect it all externally, with some extra hardware (HW from now
on), like an external USB multiple port, which is best used with its own, independent power
supply unit, then you can add external USB subscription smartcard readers, too.

WARNING!!

DO NOT USE THE USB STICK IN CONJUNCTION WITH ANY MULTIBOOT PLUGIN
BY GUTEMINE! IT MAY DAMAGE YOUR MMC, WHICH IS BY DESIGN! THESE ARE
THE AUTHOR'S WORDS, NOT MINE, AS HE IS VEHEMENTLY AGAINST CLONES!

How to add a USB memory stick internally to F500HD

HW preparation part: this is an advantage to having a Ferrari, rather than DB 500 HD; for
instance, adding a USB stick internally to your F500HD enables you to...

1) have the other, external USB port (which DB 500 HD does not have!) free to attach a USB
HDD (as mentioned, with its own power supply is always best);

2) simply move your emus, skins, picons, EPG etc. to the USB stick and make it easier for E2
to function, as you relieve the limited memory of your Ferrari, as partially mentioned above;

2a) in a well-thought-through PBNIGMA II VX image you can direct those to USB stick and

2b) one can also expand F500HD capabilities/capacity by using Flash Expander, in order to
move lots of your stuff to it, which is best, as it includes all the skins, plugins, emus etc.

Have a look at this and enjoy unscrewing those 4 screws, removing the F500 HD cover, then...
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Contrary to popular belief about size, smaller size is easier to handle, it also fits better and
after all, it is sexier, too.. ©

Later on, I will explain in detail how to do the “expanding” and how to direct EPG, picons etc.

Now, put the cover back up, place your MMC into the "centre of your MM operations" and...



10

2) Let's connect...

..fasten your (W)LAN belts...
I will only presume that you have connected your box properly to your:

-satellite dish;
-TV [SCART or HDMI cable] or Home Theatre system [many possibilities there].

However, I will explain some aspects of connecting your F500HD with:

-PC [by LAN or WLAN], directly or indirectly [viaa Modem/Router].
-internet - as above, directly viarouter or indirectly viaPC.

How does one connect them? Either via..

-crossover ethernet/network cable, esp. if one is to connect PC and receiver directly - more
info one can find following this link: http://en.wikipedia.org/wiki/Ethernet crossover cable

-or via straight ethernet/network cable, if one is to connect one's router and box, as
described here: http://en.wikipedia.org/wiki/Category 5 cable

Reserve your receiver's IP address in your router/modem

At this point, I would advise you to enter your modem/router’'s interface and reserve your
receiver's local network IP address, by tying it to your box's MAC address. This way, you
will always have the same local network IP address and you will not have to bother with
potential quirks of DHCP (automatic IP address assigning protocol -deactivate itl). It saves
some time and a headache! In fact, do it for all the devices in your home network!

This is what it looks like in my router's interface:

ADD DHCP RESERVATION

Enabla:
Computer Name: AFboxHD << Computer Name
1P Address: 192, 155. [
MAC Address: [N

[ Copy Your PC's MAC Address ]

[ Save ] [ Clear ]
DHCP RESERVATIONS LIST
Enable Computer Hame MAC Address IP Address

[ AZboxHD I G E T



http://en.wikipedia.org/wiki/Ethernet_crossover_cable
http://en.wikipedia.org/wiki/Category_5_cable
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..we're about to take off...

...into the cool and wonderful world that this jolly hobby has to offer, thanx largely to the
work of the Open Source community, that awaits on the internet, once you connect your box
to it. One should think of our boxes as PCs, since these days, many of those little boxes,
actually are small, cool computers -Multi Media Centres ("MMC").

Connect your MMC with internet, PC and NAS

Having that in mind, it is best if you setup a modem/router as your internet connection. That
way, your MMC, NAS (Network Attached Storage, a small PC serving as on-demand audio-
visual storage [and morel!]) and your PC are connected indirectly, i.e. via the modem/router.

In other words, your NAS, PC and your Sat TV receiver/STB/"box"/MMC will be connected
to the net via the router. Similarly, they are connected with each other, indirectly.

This is a better combination, to strive for, because all the components of your network are
independently connected to the net, as well as to one another.

Below, you will find a scheme that is relevant for the kind of setup that I will describe in this
document, consisting of NAS (server), MMC and PCs/laptops (both depicted here as
"Workstations"), where "Switch" = modem/router, in the centre of all the operations.

Let's pretend that one of the "Workstations" in this scheme is your F500 HD or whichever
MMC type of box you might have - because F500 HD is, after all, a small computer...

Let us assume that the "Server” is your NAS, where you store all your videos, music and
photos, from which to stream them to various devices in your Home Network (TV, MMC, PCs).

WI}I’hEH‘I[Iﬂﬂ
/Seruer

_,_,_,_,___—_p" Switch

Workstation

)

-

__J - Warkstation
(1] L)

—

Waorkstation Workstation

If this hasn't been done correctly, your box won't be connected to the PCs or NAS, i.e.
internet. If in trouble, first test your cables - just in case!
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When you are using a router, then all the machines we are considering here must have IP
addresses in a specific range, let's say from 192.168.1.1 - 192.168.1.254.

One has a few possibilities, when setting it all up: wireless (Wi-Fi) and cable (Wired)
connections. Both can be setup either automatically (DHCP), or manually (static IP).

If you tie your F500 HD IP address to its MAC address in the router itself, as T mentioned
before, DHCP will do, because your IP address will nevertheless be the same, at all times!

PBNIGMA VX II will set it up during the initial setup, via Wizard. We'll come back to it.
Cable it up (LAN) if you can

It's always preferable to cable it all up directly, using LAN cable, of course, especially if you
want to stream high bitrate content from your NAS or laptop/PC to your MMC.

Another option: connect in a wired manner but via electric cables/socket! No more long LAN
cables all over the house and wife nagging endlessly, because of “ugly cables everywhere"l©

Buy a couple of those small devices, like the one below, plug one of them into electrical
socket next to your router, then LAN cable from it into your router (LAN port 1-4,
whichever is free).

Then similarly, plug the other one into an electrical socket next to your MMC and plug LAN
cable from the device into your F500HD!

You're on the net! Simple as that! Tested!!!
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Wireless (WLAN): issues...

Some MMCs have WLAN built-in, some don't.

However, one can connect wirelessly to one's router either viaa
-USB dongle or a

-dongle that uses LAN port.

WLAN is necessary on occasion, but I can't help you with that, sadly. Use the support
forums, where you should get a lot more information and files needed, on just about any
topic, this included... (There are devices for all occasions...)

Later, we shall come back to some of these details, when we speak of setting up a newly
installed E2.

For now, be aware that it is essential to have this sorted out beforehand, since we will be
using a PC application, in order to “flash" E2 into FBOOHD, using F500HD's local network IP
address!

In fact, that is the next stop on our little journey - putting PBNIGMA II VX into your box...
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3) IN MEDIAS (ST)RES!!

We shall now install and then configure PBNigma-Ferrari-dm500hd-121101, downloadable
here: http://www.pb-powerboard.com/board/index.php?showtopic=95602

The core of the whole operation we shall describe in small, methodical steps - no sweat! Chilll

How to "flash" FB00HD with PBNIGMA II VX

Don't worry, it's dead simple. Reallyl. Nowadays, things are becoming seriously simplified!
The Web Browser method

This is the simplest way of "doing it" and it doesn't require any special SW, cabling (other
than a simple LAN cable, which every household has) or previous knowledge. This guide will do!

Things you need...
1) An "Image" in *.nfi format (see PB and Ferrari forums, of coursel).
2) Inyour Home Network, your router should either

-have DHCP server activated (automatic home network IP address assigning [it's mostly "on”
by default, so chillax...]) or

-have an IP address assigned to F500HD manually, tying it to its MAC address, so it always
gets the same IP address, no matter what, as I explained earlier. That is the easiest solution!

3) Ferrari must be connected to:

-your router via a LAN cable (straight or crossed [I am not sure about WLAN]), as well as
-your TV via HDMI cable, plus

-your TV must be switched on.

4) The SSL (Second Stage Loader) must be fully operational (and compatible with the E2).
The procedure
1) Switch your Ferrari off: at the back, there is an OFF switch. (Standby via RCU won't do!)

2) Press the "power button" at the front of the receiver and hold it firmly. (Don't push it
up or down, so it can be released into original position, i.e. so it doesn't get stuck.)

3) Switch your Ferrari on, at the back, but never letting go of the "power button".
4) On your TV screen you will see your rec's IP address.

Note: Release the button about 5 secs after the screen flickers the first time, as it
hasn't yet done the job, when it flickers initially. This is what you should see:


http://www.pb-powerboard.com/board/index.php?showtopic=95602
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5) Now, in your Web Browser - Firefox (or whatever you use) - write that IP address in
the address box at the top, like this: http://192.168.x.x/ - where x = Ferrari's specific
address in your Home Network. Press "Enter” on your keyboard.

Note: SSL (Second Stage Loader) version may differ from the photo below. Mine is SSL87F
and it is required for the E2 mentioned. Get the SSL87F (or whichever one you may need)
from http://www.ferrarismartcard.com/ and repeat the procedure I am about to describe in
detail, with the SSL file as well - with one difference to the procedure here described:
namely, switch OFF and ON F500HD at the back, both after flashing the SSL and the E2.

So, to the procedure itself now.. You will see something like this:

DMS00HD second stage loader #83 (2011-03-01)

S

If you see this, your Dreambox didn't boot the Linux kernel. Unless you
interrupted the boot process, this usually means that your Dreambox doesn't
hawve a valid operating system Installed.

Don't worny! Tt's not a problem. You can just flash a new version and everything
will be fine!

Otherwise, you can boot from network or USB.

If you're about to give up, you might get help at the Dream Multimedia Su
board!

You can download the current flash content, but please don't expect to be able to
flash it back. It's merely a debugging feature.

= Device information

» Firmware upgrade

Click on the bottom bit: "Firmware upgrade”.


http://192.168.x.x/
http://www.ferrarismartcard.com/
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This is the next image you will see:

) =Ml 0O OC

Firmware upgrade

Selectnf e N AT

Note: The file upload may take several minutes.,

6) Use the "Browse..." button to find (on your PC's HDD) and choose an image you want to
“flash"/programme/“burn” into your Ferrari - once it is highlighted - click on "Open"!

-~

Mame Date modified Type Size

II_, PEMigma-1.0-dm500hd.nfi 01/11/2012 03:56 MFI File 43,914 KB |
PEMigrna-Ferrari-dm500hd-121101 tar 01,/11,/2012 08:10 tar Archive 43,920 KE
iC) PBMigma-Ferrari-dm500hd-121101 tar.gz 02/12/2012 16:20 gz Archive 41 522 KB

7) Now, go back, up a bit, to the photo regarding flashing/upgrading: click on the "Flash"
button and wait a bit. Patience! When it's done you'll see this message in your WebBrowser:

Firmware upgrade complete. You may restart your Dreambox now.

Under it, one will see "100%", if all went well. Then, click on "Reboot" button. Your Ferrari
should now "boot"“/start with a new image in it. You should see this boot (TV) screen:




4) PBNIGMA II VX initial configuration!

An initial configuration Wizard starts now, helping you to configure all sorts of things,
starting with your FS00HD - TV connection...

“efealuarre ;

8

ou can sse this page an your
ent input poarth

Box Control -

ut port will be automatically probed
in 20 seconds

Choose whatever HW you have and whatever resolution it allows etc. T am choosing HDMI for
best connection, at the best resolution possible with this MMC/HW - 1080i.

After that, choose the language, networking connection and so on. I normally skip it, after
choosing the language and proceed to set it up manually, as my tuner setup is a bit complex
(details on that are coming). But just use your common sense - if I didn't describe every little
step in this part of the procedure - according to your HW and needs/preferences.

01.Jan 1:12

Video mode selection.

English
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Most network and similar default options during the Wizard's configuration procedure are
OK, so just confirm them.

If you want it done differently, then do it manually afterwards. T'll try to cover some of that,
since PB Team have moved on to the excellent OpenPLi Team's SW sources for their new
image. OpenPLi E2 menus have many more options, compared to a standard E2.

The link o OpenPLi team's portal (and from it the forum) is: http://openpli.org/

Post coital bliss... or frustration... depends on the day...
If all is well, your "RCU" will function normally and you will give commands using it.

However, when I got my F500HD, the front panel was faulty, hence the beam from the RCU
didn't connect. The front panel had to be replaced and then it worked! So...

In case of trouble: Webinterface access to E2

If your RCU or remote sensor are faulty, one should still have access to the box, via
WebInterface E2 plugin. We also use it to stream from F500HD to a PC... More later.

In that case: WebBrowser - one writes Ferrari's address like this: http://192.168.x.x:80 >
hit "Enter” button on your keyboard - click on Box Control > Web Remote and that's it,
controlling it viaPC/laptop, using your Home Network (as shown below)...

PB POWERBOARD Send "loog” Keypress
TeleVision Radio

othing running

BoxControl Favourites (TV)

PowerControl
Send a Message
WebRemote
Screenshot (AN)
Screenshot (Video)
Screenshot (OSD)

EEEEEEEEEE

EPG-Search

Search EPG

Of course, this is highly unlikely to happen!

But sometimes, it does, so I thought I better mention it, fo prepare you, if something like
this happens again, due to harsher transport conditions or any other cause of such
malfunctions...


http://openpli.org/
http://192.168.x.x/
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5) Power Board Centre

This is the secret of this excellent image - amongst other things, such as great online
support for precisely this machine, a "clone”, with plugins that are safe for itlll

PB Centre is a well thought through and carefully executed set of integrated tools,
giving one all that is needed in order to set up the machine, combining all manner of HW
one might want to connect with F500HD! This is what makes it the best E2 image, IMO!

It's just pricelesst T will try to show you how it works, what some of its capabilities are, plus
how to best use it, easily. We shall also use it to see the internal structure of E2, create a
SWAP file, mount additional external USB HDD and so on and so forth.

Before all else: ‘expand’ F500HD limited ‘flash’l

Ferraris (and original DBs) by design have a flaw: low memory capacity, which then has to be
enlarged in order to accommodate emus, plugins, large EPG files, tens of MBs of picons,
subtitles, heavy skins, tools, long channels lists and whatnot, that we may play with...

We shall now use the USB memory stick that we prepared earlier and plugged it into
F500HD's internal USB port. More precisely, its first, primary partition will be used to
"expand” the FBOOHD's limited flash memory. Everything else has to wait and then we are
free to do all manner of things, without fear of overloading the memory and making E2
unusable - having to re-install everything, when we hit the proverbial HW wall...

Originally, MMC device was installed in DBox2 by ketschuss and it seems geko37 and darkvolli
wrote the plugin. Mechatron re-coded it for DB (/usr folder is moved to a USB device) and
PB Team (Stibbich and co.) re-wrote the plugin and included it in all PB images. This PB
plugin moves the /usr/share/enigma2 and /usr/lib/enigma2 folders to a chosen USB
device/partition, so we never run out of space and our box will perform speedily and stably!

We simply enter the PB Centre by pressing the blue button on our RCU and we get this menu:

Input

Please choose an extension...

1 Graphical Multi EPG

] 3, Fhaard
, [ i

Let's see its structure and then go to find the Device Manager, in order to "mount” the USB
stick that we already plugged into our machine (i.e. connect the HW and SW, that is o say
"make it usable/accessible/re-writable”, in this case)...
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We prepare by "mounting” a USB device first...

PowerboardCenter o1.Jan  2:05

i- 4 Addon Manager

Cam Manager

PB-Newsreader

F‘F’

YETEDOAl - y SLEM-38 "_.i:-
Powerboard-System-Settings FrewrCcnEoARD

Powerboard-5System-Info ~ —
f

Team-Info

. Restart GUI

Press > OK on your RCU - takes you to System Setup section of PB Centre, where we see
many great tools, all in one place! They make the functionality of PBNIGMA VX ITI the best!

PowerboardSystemSetup 01.Jan  2:15

Satfind
Classic Systemupdate

ol
FE-Backup-Manager

PB-5etEPG-Path rewcCnEOARD

PB-SetPicon-Path [ T—
4

Delete plugins andfor crashlogs

Camd-Installer-Uninstaller

PB-Expert-Installer

o
&
o
%

IPK-Incraller

To the best of my experience with various images and plugins of this sort, we shall start with
the best E2 plugin/tool of the sort!

..Device Manager...

I will show you how I mounted the 16GB Cruzer Blade USB stick, divided into 2 partitions.
The first one is approximately 16B and the rest of it I used for the second partition.

Press OK on RCU, to get into the Device manager and there we see this menu:
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Drive Setup 01.Jan  2:20

- e

FoWERBEOARD
— —_—

MR

Partitions itialize ' Swapfile

Please note the following buttons: "MENU" (bottom left corner), "PARTITIONS"(red) and
"SWAPFILE" (blue), in particular. We shall, "expand” the receiver's "flash” via "MENU"
button, after we "mount” various partitions first and then create a SWAP file, after that.

If one wanted to format a partition using PBNIGMA II VX, one could do that! Moreover,
one has many cool options, to do it! This being a carefully and thoughtfully coded set of tools,
distinguishing this image from all others, one can choose Windows or Linux formats, like
EXT2, EXT3 (my choice) etc. But since I did it earlier using my PC, I do not need to do it now.
However, it is good to know one can do it internally, using PB E2's great capabilities!

To “format” a partition use the button, to "mount” a partition press the red
button, in order to explore the device and to choose what one needs for a specific function.

Hard Drive Partitions 01.Jan  1:01

Partition 1 - Limux 1011 ME

Partition 2 - Linux 14252 MB
-_— F—

FOWERBOARD

- —
'
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I chose the first partition, in order to mount it as /media/usb (see below).

Hard Drive Mount

Mount as /media/hdd
Mount as /media/hdd1
Mount as /media/hdd2
Mount as /media/hdd3
| g | Mount edia/ush
Mount as /media/usbi
rowcneoane ot o imedauhd
L as | e LS
[ il — ;
g Mount as /media/cf
4 Mount as /media/mmc1
Mount on custom path

The second, larger partition I mounted as /media/cf, so I do not accidentally confuse it with
the smaller, "flash extender” partition! You can see the results below.

Hard Drive Partitions 01.Jan  1:10

Partition 1 - Linux (/media‘usb) 1011 ME

Partition 2 - Linux (/mediase 14252 MB

FF‘

FeWERBOARD
— —

Unmount

Now, I can "expand” the F500HD flash memory to /media/usb (partitionl) and direct/send
other stuff to /media/cf path (partition2), with ease, using only RCU!

Flash Expander function in action

OK, now that the partitions are "mounted”, i.e. accessible to E2, one is ready to go back to PB
System Setup and "expand” to the first partition of the USB devicel
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Here is how: PB Centre - System Setup > Device Manager - once in it, the USB stick
has to be highlighted/coloured, which means chosen, then press MENU button on your RCU...

Drive Setup 01.Jan  7:41

FF‘

FOWERBOARD
_— —_—

MICHL

Partitions

Swapfile

..then, one gets the menu below and chooses the first, smaller partition, then presses the
green button > Expand to device...

Expander 01.Jan  T7:43

Partition 1 ux (fmediafusb

f— f— Partition 2 - Linux (/fmedia/cf) 14252 MB

FoWERBOARD

- r—
f

Expand to device Get rid of expand

.."Expand to device" command gives you another screen, asking you to confirm, if memory
serves, then a notice that it is working (moving the /usr folder to the chosen
partition/device)...

Eventually (it'll be quick, don't worryl!), it will notify you that it succeeded, plus that it has to
reboot/restart E2, once it is finished, in order to activate the new configuration of your E2
setup... OK, maybe in not so many words but this is the gist of it all...
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Swap File: surviving big updates!
We are now ready for the next step: creating a SWAP file on /media/cf.

OpenPLi Team - the originators of sources for this image - say that they do not think SWAP
file is needed for normal, everyday operations.

However, sometimes one might have in excess of 40-50 files to upgrade and then it is better
to have it ready, if one doesn't want to risk a failure to upgrade! One can deactivate the
SWAP file afterwards, as it is so easy, with PB. You can see in these photos how to do it! So
simple!

Let me just add: I have it activated at all fimes and my F500HD performs like a - Ferrari,
hehl!ll No problems whatsoever!ll At least not in this regard...

How do we do it? One has to be in (see above) Drive Setup Menu and press the blue button,
when /media/cf is chosen (highlighted/coloured).

One is then taken fo Swap Manager menu and these options (see below, what I chose):

Swapmanager 01.Jan  1:19

Activate Swap File? ¥EE
Swap file size 128 MB
wap fle location MPACT FLASH

F’F’

FoWwCRBEOARD
_— —

Then, when I pressed the green, "Save” button, it gave me the window below...

Sorry, things were too fast to grab every screen that happened, at this point - so, T won't be
able to list the whole process captured in the same manner... but trust me, it all works finel

Just to add one more thing: once it is done, you will be notified that it was successful > just
exit Device Manager and enjoy further configuring your PBNIGMA II VX.. ©
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Creating Swap file...

Creating swap file, .,

I can demonstrate all this visually, by going into PB Centre > System Info > Memory...
Memory 01.01.2000

Execution progress:

total free shared
Mem: 137272 11392 0
-/+ buffers: 11612
Swap: 131064 130708
Execution finished!!

Then, we go to > Image Level..

Image Level
Execution Progress:

Filesystem Available Use®: Mounted on
Sdev/root 14.8B0 75% /
1.70
64,
66, fvar/volatile
896. 5% /media/usb
12. 1% /mediasct
BO6. 5%

y 806, ]
JSdevssdal 896, 1W % Jusr/Sshare/enigma?

..Then > Show Mounts...

Show Mounts 01.01.2000 7:19

Execution progress:

rootfs on / type rootfs (rw)

Jdeviroot on / type jFfs2 (rw)

proc on JSproc type proc (rw)

sysfs on /sys type sysfs (rw)

udev on Sdev type tmpfs (rw)

tmpfs on /media type tmpfs (rw)

devpts on Jdev/pts type dewvpits (rw)

usbfs on /Sproc/bus/usb type usbfs {(rw)

tmpfs on Svar/svolatile type tmpfs (rw)

Jdev/sdal on Smediasush type ext3 (rw,data=ordered)
fdev/sda2 on /mediascf type ext3 (rw.data=ordered)
Execution finished!!
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..and finally, Spaceview -> CF...

View Space of /media/cf 07.12.2012  3:10

Execution Progress:

Size: 13.76

Used: 139,28

Available; 12.96G

Use in %: 1%

Hounted on: Smediasct
Execution findshed!!

..and > USB...

View Space of /media/usb 07.12.2012

Execution Progress:

Size: 995.9H

Used: 49, 2M

Available; 896, 1N

Use in % 5%

Mounted on: /media‘ush
Execution findshed!!

OK, that done, we shall finish setting up external devices by mounting an external USB HDD,
with its own PSU (Power Supply Unit). FEOOHD's USB port doesn't have sufficient power to
supply the large HDD that I will use (1TB WD Green Caviar).

Mount a USB HDD using PB's Device Manager

I shall use a USB HDD only to record to it. As I said before, all the other bits will go to
/media/cf partition of the USB memory stick, which I plugged in internally.

So, let's prepare the USB HDD for functioning under E2:
1) exit all the menus before you plug a USB HDD in;

2) wait until PB-E2 VX tells you what it found (if it finds anything on the disk - in terms of
media ["playable”] files) - press OK, so the window disappears, /f it appears;

3) Blue Button > PB Centre > PB System Setup - PB Device Manager.

Btw, do not "initialise” your HDD under any circumstances ( button), as you would lose
all that you have on the disk!

You can check it by using the green button- it's a useful function - for speed and
consistency/bad sectors/errors!

So, I got this menu, entering the Device Manager:
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Drive Setup

953869 ME
— F-

FoWEREOARD
_— —

Swapfile

Hard Drive Partitions

FF‘

FewWECRBOARD
_— —

Now, one can choose how to mount the partition by pressing the red button!

Hard Drive Mount

Mount as /media/hdd

Mount as /media/hdd1
Mount as /media‘hdd2
Mount as fmediafhdd3

f f Mount as /mediafusb

Mount as /media/usbi
Maunt as fmediafusbh?

CRWERSSATN Mount as /media‘usb3
i as 4 @ FLUS0
ol — 2
; Mount as /media/cf
4 Mount as /media/mmed
Mount on custom path
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I chose the first option, i.e. I mounted the partition by pressing the red button = "OK". Tt
became media/hdd but it is mounted as /dev/sdb1 (if you press the green button to check it,
you will see as which device it has been mounted. You will get an error message but don't
worry, don't despair, keep your cool. This is what you need to do, in order to sort it out...

One must edit the E2 fstab file now, in order to add the USB devices (USB partitions and an
HDD partition). How do we do it? By using FileZilla Client, we enter the F5O0HD's PB E2 and
in /etc folder we find the fstab file to edit.

How exactly do we do that? In a few paragraphs below, I will demonstrate in detail...

For now, let me just add that I edited the /etc/fstab file by adding the following 3 lines:

/dev/sdal /media/usb auto defaults 00
/dev/sda2 /media/cf auto defaults 00
/dev/sdbl /media/hdd auto defaults 00

One must now reboot (Full restart in the Main Menu - Power Management). Sometimes
several times... until you have these results:

Find them in PB Centre > System Info - Image Level - a list of devices/partitions:

Image Level 07.12.2012  4:15

Sdev/sdbl 915, 26 241.36 627,36 28% /media/hdd
Execution finished!!

In PB Centre - System Info - Show Mounts...

Show Mounts 07.12.2012 4:19

Jdev/sdbl on /media/hdd type ext3 (rw,data=ordered)
Execution finished!!

Sometimes the “"check” function will return "Error" message but the device should now work!

Main Menu > Media Player - "Desktop” can be seen, it can be accessed and films in various
formats can be reproduced (although some with DTS sound can't be heard, but the blame, it
seems, lies with the OpenPLi, primarily - apparently they are working on it).
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Here is the proof - the content of the USB HDD's (/dev/sdbl) only partition:

MediaPlayer 07.Dec  4:29

i 1ch
B backup no c over
= font
| movie
i music
I picture
sl pvr
i settings
m var
PLAYLIST

OK, now we have to enter E2 via FTP, in this case FileZilla Client, in order to make some
folders and so on. Moreover, I need to explain the major functions in FZC, to make possible
what I mentioned earlier - editing the fstab file, as well...

How to work with FileZilla Client (FTP)

To connect one's PC with one's box, via FTP, one can use FilleZilla Client ("FZC" further on).

Download it, it's gratis, ( http://filezilla-project.org/download.php ), install and start it. . Put
in your box's IP to the Host box (something like 192.168.x.x), use root as username and
dreambox (or whatever it may be) as password, port 21, then click on > Quickconnect.
Later, you will only need to use Reconnect, under Server, since FZC saves this data.

[ reorz 192 16 ez -l - - T - N

File Edt Yiew Transfer Server Bookmarks Help HNewwversion available!

I el el - Rl R )

Hast: 192, 168.x.x Usermame: root Password: sesssss Port: 21 Quickconnect ||~
Ep—— e LA thE wpancer S Share ergea
PASY

LIST -a

mre cpmes the drect e

Directory lstng successful

Local ste: | TW\AZbug HD'EZPlugniPingfloodl, + | Filename ) Files | Remote site: | fmediaFlashExpander * | Filename
Plugir . E [ FlashExpander
EMC enigmaz-phag I ingflocd.igk ams | T lost-found lost+Found
g gmal-plugin-extensions-keymap-pingflocd.ip 207 | lost+found
im” B enigmal-plugin-extensions-keymap-pingflocd.zip 0k | "":'b s
& i enigmad-plugin-extensions-ofw-launcher-pingfio... 15| s
Flash Expander | 2 games
PR a:nl:|r—a!-|:|Iu:||n-r:d:n%lnn%-c').—-laun:h:r-plnq'!:... 1E | i =
GP3 Wiz . 7 include
: enigmal-ckin-azhax-pro-hd-de.ipk 953.C |
Hide Zap Errors B leys
R a’:ﬂl;I"'Hz-'.—klrl-dll‘.lux-p'II.'-'lﬂ-d"..ldr 9531 | 2
P TV | T lib
Keymap T libexec
MC 032 T sbin
bounthanager ¢ T scam
lultirmedest ek T scce
Pingflood + share
Scaling maodes B =c
skim 2 hdd
subtitle player 2 mmcl
; SWAP - —1 L net
g ' & files, Total size: 1,950,978 bytes 2 ram - |2 directories
Server/Local file Direction  Remote file Size Priority Status

Queued files | Failed transfers Successful ransfers
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Setting it up for my laptop, I choose Edit = Settings - Interface > Widescreen. That
gives me 2 main windows [laptop and Ferrari], each of which has 2 more windows: a tree and a
view of a chosen folder. Then, it is easy to drag & drop from one to the other, in speed...

Drag and drop means click on a file or group of files, to choose it/them, then left-click on
them and do not let go! Drag it/them to the folder of the other machine and drop/let go.

You will see if the transfer was successful in the top part of FZC, as well as the bottom one.

To automatically start Notepad++ application on your PC, when you choose a file to view or
edit (by right-clicking on it > View/Edit) in FZC, one goes to: FZC - Edit > Settings - File
Editing > Use custom editor > find the Notepad++ executable file.

In my case, it is (Windows7): "C:\Program Files (x86)\Notepad++\notepad++.exe".

One might have to create a folder, occasionally: right-click on a folder where you want to
place it > Create directory - give it a name > OK.

Sometimes, after that or a transfer, one needs to do the so-called CHMOD command to a
folder and/or some or maybe even the whole of its content.

How does one do it? One must right-click on it > File Permissions > 755 > OK. Reboot your
F500HD, if necessary, for the changes to take effect.

A few simple tasks to complete the devices setup
In the PB E2 image there are 3 easy ways to set up recording, picon, subtitles and EPG paths.
1) MENU - Setup - System Settings > Recording, EPG and Picon Path.
2) Blue button > PB Centre > System Setup > Set EPG Path and Set Picon Path folders.

3) One might also configure some of those paths in some skins, like HD Glass skin (picons
etc.) or in some plugins themselves, like CrossEPG or DDsubtitle Player. More later...

In that case, one must be very careful, so that all those paths are the same! Plan it, so
you can execute it in a consistent manner, insuring a well organised/structured E2!

So, I created picon and subtitle folders in the appropriate location (/media/cf/) or I
merely chose the /cf folder for the data to be stored there (like EPG) > Save (green).

Naturally, recordings are going to /media/hdd/movie folder or a specific sub-folder in it.

After one sets up an appropriate picon path in PB System Setup, "Restart GUI" (Graphical
User Interface) is mandatory...

OK, moving on now, to sending a channel/"settings" list (that somebody already made for us
and posted on the net) to E2 and after that we can finish the major configuration tasks...
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6) Channel list

A channel list can easily be found on the net or in blue button > PB Centre - Addons. T use
Don@'s, as I am from EX-YU and those are the first Favourites they put in. You may need
some other list fo suit your needs or you can edit such an up-to-date list yourself... How?

Edit a list

Open DreamSet Editor to edit the list according to your needs. One can easily delete or edit
the names of whole satellites or a number of transponders or channels. One can create
favourites folders, so they correspond fo what you can't get where you are. Or delefe the
ones you're simply not interested in, then re-order them as you want them to be etc.

How exactly? Well, place the cursor on the icons there - it's all more or less self-evident...

When you right click on any satellite or transponder or channel (see below), you will see many
possibilities... It's a well written editor for this purpose, so just enjoy messing about!

%, DreamSet 2.34 - DASAT TV\AZbug HD\E2\Liste kanala\Deona\13.8.11\Moj edit 13.9.11\lamedb
j

O | @ . d &8 53| 5 | & | I N -
Mew Open Save Save As  Motes Import Control Transfer  Setup

Organize Lists | Ede Settings | Search | Statistics|
TN 08 0F  Astra 2402820, Eurchird 1 (2 (G | S e | K

4}: x @ E a # }< @ E E % Delete Satellite l

Freg 5R Po Fec = Service id Type Prowider VFid APFid
0714 22000 H 5% & Channel 4 216 TV BSkyB 2347 2348
0729 2000 V 5% éa Channel 4 w281 TV BSkyE 235 2316
10744 22000 H 58 |_| | 6 Channel 4 9211 TV BSkyB 2315 2316
10758 22000 V 5% | ¢ Chaninel 4 9212 TV BSkyB 2327 2328
10773 22000 H Auo e Channel 4 9213 TV BSkyB 2332 2333
1NTRG  ¥INNN \r L < B Mareal A aMaA TW (= 1={FN=] 77 el ]

Save your editing, after you're done, then close DreamSet.

Mind you, one can upload lists, using the editor, too... However, I use another one, for that
task...

Upload a list to your box
To do this I use DreamBox Edit. Open it and configure it properly. See the image below.

In "Options" one may choose one's PC folder which contains picons and a folder to send it to
in E2. Cool but FZC does it faster, I think. DBE first compresses the picons, transfers the
file to /tmp, then decompresses it and sends it to wherever you chose to send it, I think...
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dreamboxEDIT Options

Profiles | General | Messages Color zcheme | Advahced | Ficon | Streaming

Enter the IP address of the Dreambox (ke 192, 168.0.5 or MyDreambox, DYMONS, COM etc.)

Selected profile: Metwark settings i
Ferran IF address of Dreamb-. HTTF part: e .
192168 an default B0 et onnection
Profiles - [ I
Farrari |lzermame on Dreambos: FTF port:
AZhoxHD raat 3 [default 21) Test Usemame / Pazzword
Fazaward on Dreambos: FTP type: ;
(@) Passive [default) Reset all TCPAP options bo defaults
() Active

File pathz on the Dreambox
Service: and Bouguets files: Fiezet Dreamboy file paths
Jetcfemigmal’ to their defaults for:

Uzer bouguet files: Enigmaz zettings

fetclenigmazs ) :
Satellte receiver

Satellites. wml file:
fetcftusbon Cable receiver

Path for Picons on dreambos:
Mew Profile fmediascf/picons

Terrestrial receiver

Save Prafile

Delete Profile

Cancel Save

Then > Open - find a list on your HDD > FTP = choose according to your needs (send
picons or not, to the chosen E2 picon path folder, for instance) - the list itself goes quickly.

When it is done, give > "Reload settings” command in DB Edit, in order for the newly
uploaded list to become active/accessible. Restart E2 now, using RCU.

Tuner configuration
I do this now, and not before, because I have to go only through the satellites I need!!!

So, save yourself some time, by investing a bit of time in editing a list, according to your
needs, delete everything you don't need, re-order it efc.; put it in E2, reboot and now go to...

MENU -> Setup > Service Searching - Configure Tuner > "advanced" for me, since I use 16
LNBs via DiSEqQC 1.1 protocol, 16in1 switch for 19 satellite positions, caught by T90 dish.

Then, one changes only the following parameters, from the whole list:

-LNB [1 > 16]

-DiSEqC mode [1.1]

-Fast DiSEqC [yes]

-Command order [uncommitted, committed, toneburst]

-Uncommitted DiSEQC command [Input 1 > 16, as above, it must correspond to your LNB
numbers].
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Here are some images of my “extreme" setup, so it's more 'concrete’ for the ‘less informed"
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T have 12 Twin LNBs (2 cables coming out of them, feeding 2 tuners) and 4 Quad LNBs (4
cables potentially coming out of them, feeding 4 tuners but I only use 3 at the moment).

Hence 3 switches: 2 x 16inl and 1 x 4inl, as you can see below...
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A lot more info on the topic you can find on the great PB forum ©

http://www.pb-powerboard.com/board/index.php?showtopic=85684

If it is a simple setup - up to 4 LNBs - then choose DiSEQC 1.0 protocol.
If you have a DiSEQC motor you will need either DISEQC 1.2 or USALS protocol.

I will not cover those here, since I could not test it myself and because there is a lot of help
to be had on the forums I mentioned earlier, with step-by-step guides, as to how fo setup a
DiSEqC motor using either DiSEQC protocol 1.2 or USALS.

Good luck with that!

We're now ready to move on to...


http://www.pb-powerboard.com/board/index.php?showtopic=85684
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7) Configuring an OpenPLi E2 generally...

Since I didn't use the Wizard fully, at the beginning, I must sort out those bits now...

I will simply use photos/images/captured TV screens on my laptop (remember, Open Web
Interface plugin?), as they "tell” many words, all at once! Sometimes I will also explain why I
chose a specific option...

Main MENU button on your RCU - Setup = System Settings - see the image below. As you
can see, the OpenPLi E2 has more options than standard E2 and once inside those options one
can see even more possibilities to set it all up to one's liking/needs... Let's go!

System Settings

/ settings
Other Settings
Graphical User Interface
Electronic Program Guide
Recording and FileList
OpenPLi Advanced Subtitles
Auto Language Selection
Hard drive

Metwork Setup

Audio-Visual
This is to be sorted out according to your other HW - your TV, various connections...

Setup

A/Y settings

Mode
Refresh rate

Display 4:3 content as Just Scale
Display =16:9 content as Letterbax

AC3/DTS downrmix yes
General AC3 delay 0
General PCM delay o
0SD transparency |
Scaler sharpness |G

Use < and > buttons on RCU to change the values, then save them with green button (OK)!
Exit button, when done and we move on...
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Other settings

Here you have a number of options. I disable the background scanning of channels, for
instance. If you have an additional DVB-C or DVB-T tfuner plugged into F500HD USB port,
change the priority to your needs and so on... Green button to save, when done, then EXIT...

Etup
Other Settings

Enable teletext caching yes

Alternative services tuner priority DVE-3/-T/-C
Preferred tuner auto
Disable background scanning ¥es
Create more detailed crash log yes
Include EIT in HTTP streams

Include AIT in HTTP streams

Include ECM in HTTP streams

Descramble HTTP streams

6UT - Graphical User Interface

Setup

Graphical User Interface

Show animation while receiver

Show positioner movement

Enable multiple bouquets

Multi-EPG bougquet selection

Alternative numbering mode

Change bouguets in guickzap

Hide channel list in radic mode

Action on long power button press show shutdown mend

Action on short power button press Standby
Position of completed timers in timerlist atend

Iinfobar timeout

Show event-progress in channel selection
Show channel numbers in channel selection
Show infobar on channel change

Cancel 3 e e

I don't have a motor, for instance, so I don't need to see "motor movement”, I want infobar
shown a little longer, especially since I like using HD Glass skin, which is loaded with info of
all sorts etc.

Below is the second part of GUI settings, where I choose to “hide zapping errors", which can
be annoying and OpenPLi Team have coded it wisely, as usual, to give us this option, just like
the option to supress the background channel scanning...



38

Setup

Graphical User Interface

Show infobar on event change

Show second infobar

Show background in radio mode

Hide zapping errors

Hide Cl messages

Show crypto info in infobar

Show SHR percentage instead of dB value

Show EIT now/next event in infobar !
Behavior of '0° button in PiP mode standard

EPG
Here you can set your preferences, depending on the satellites/packages you get and follow...

Setup 07.Dec  15:15
Electronic Program Guide

Enable EIT EPG
Enable MHW EPG
Enable Freesat EPG
Enable Viasat EPG
Enable Metmed EPG

Maintain old EPG data for (minutes)

I'm a maximalist, as you can see, hence the Expander, so I can activate all of these, hehe...

I will only show the menus in which I actually change some options, so going to subs now...
OpenPLi advanced subtitles

Well coded, as T mentioned, it gives more options to manipulate various types of subtitles...

Setup 07.Dec  15:20
OpenPLi Advanced Subtitles

aletext subtitle color
Use original teletext position ne
Rewrap teletext subtitles no
Subtitle position &0
Subtitle alighment center
Subtitle border width
Subtitle font size
Subtitle delay when timing iz bad
Yellow DVB subtitles

Use original DVE subtitle position original
Center DVE subtitles i
DVE subtitle black transparency

Yellow external subtitles
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Of course, some of these will be working together with some independent plugins, like
CrossEPG, DDsubtitle Player and so on... More later...

Auto Language Selection

This needs to be setup according to your households needs - try various options and see what
works best for your family's needs...

Setup

Auto Language Selection

. guage selectiorn
Audio language selection - 2
Audio language selection - 3
Audio language selection - 4
Prefer ACY sound ng
Prefer audio stream stored by service yes
Subtitle language selection - 1 Hane
Subtitle language selection - 2 Hone
Subtitle language selection - 3 Hane
Subtitle language selection - 4 Hone
Allow subtitle language to equal audio language All
Allow subtitles for hearing impaired no
Prefer subtitles for hearing impaired
Prefer DVB-graphical subtitles

Cancel = _— - —

The new and interesting thing about this is that you can mix and match subtitles, sound and
language settings to best match your needs... Think about it and try...

T usually skip the Hard Drive part, as I prefer Device Manager options in PB Centrel
Network Configuration

Here you will enable your F500HD's E2 to connect to the Home Network and Internet.

I already explained some parts at the beginning of this guide, so I won't repeat it.

Network Configuration

LAM connection

Nameserver settings
Metwork test
Restart network
Mount again

Edit the network

configuration of your
receiver. MountManager

Press OK on your remote  WetworkBrowser
control to continue, Network Wizard
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Network Setup 07.Dec..15:41
Current settings: AN connmctian

IP Address ST P

192.168. Use DHCP

Metmask IP Address

255255 255.0 Netmask
Use a gateway

Gateway Gateway 192,164,
192.168.
Primary DN5

192.168.

Secandary DM5
0.0.0.0
Press OK to activate the settings.

~Cancel - Edit DNS

However, we will need to speak more about streaming from the Home Network, later on. I will
explain how to "mount" various network drives, like NAS or PC/laptop...

I have a Synology NAS, which has a Linux OS, so it is using a better, superior, so called NFS
protocol for streaming A-V content from NAS to a MMC. When I enter this option I get the
following results of the neighbourhood scan:

Network Neighbourhood

-~
;‘L 192.168
q—

";"'1_ 192.168.
=

Press OK to collapse this
host

% /volumel/video
. 172,168,

P (W /volumel/photo
B W 192158

P W /volumet/music
B A 192168

One chooses one of those shared folders, edits its name and presses OK to activate it. It is
that simple with Linux. Windows protocol (CIFS) is a little bit more complex. More later...

If you did it well you may get a result similar to the following image of my setup (press the
green button in this menu, then Mountpoints management):
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MountView

IP: 192 168.

Dir: volume/video

Press OK to edit the B
settings. - IP: 192,158,
Dvir: volume1/music
IP; 192,168,

Dir: volume1/photo

As I mentioned, I will come back to many more details, so anyone can set up their Home
Network in various ways, for various OSs and using different techniques... 'Till it works! ©

Just one more photo, before we move on, so you can see where you can do it "manually”, as
opposed to an automatic scanner built into the E2, as seen in the previous photo:

It's in Mount Manager > Add New Network Mount Poinf:
MountEdit 07.Dec  16:02

Active enable
Local share name

Mount type CIFS share
server P 192.168.0.0
Server share fesiport/hdd
use as HDD replacement s
Mount options rw

Press OK to activate the
Username

settings.
Password

1.:;/-_ abcZABC def3IDEF
ghidGHI jELSIKL nno6HHD
pars7PORS tuvBTOV wryz Wk
= 0, ThaEE="+"{ 1§~ E

Enable it, give it a name (like "Film"), choose the protocol (NFS or CIFS), write the address
of your server, then the name of the shared folder (for instance "Videos") and > OK!

Speed up response times for your RCU commands

Choose Input Devices > dreambox remote control (native) > green button on your RCU, in
order to edit those options, so you can speed up your RCU commands/response times - Yes.

Response times can be decreased from default values to, say, 30, msecs for the first
parameter and 100 msecs for the other > green button > Yes. And you're flyyyyiiiinnggg...
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Input device Setup

Cancel OK ——
Change repeat and delay settings?
Interval between keys when repeating: W
Na w hafora ket it start I

Most of the rest of menus are self-evident and do not need explaining... muchly...
However, one or two do and I will give you the commands fo set it up now:
Recording Paths

Setup 07 Dec 16:19
Recording Paths

Default movie location SmediamddmovieRecorded rom sat’

Timer record location
Instant record location

To change the "default path” (of your "movie location”) fo what you want it to be, according
to how you setup your additional HW, as described above, in Device Manager section, press
OK button on your RCU, then > MENU on your RCU - see the photo:

Selection Screen

.-'a switch t lelist

2 remove bookmark

Press OK to enter filelist...

elect Location

Default movie fmedia/hdd/movie/

location
e <

Bookmarks

fmedialfct!
/media‘hdd/movie/Recorded from satf

Press OK on RCU to get to a higher/parent directory and choose a folder to record to by
default, like in this photo...
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Select Location 07.Dec  16:28

Default movie /media/hdd/movie/Recorded from sat/

location
I Joza Bocek

]

||

=

L]

. R
Bookmarks

fmedia/lcf/
/media‘hdd/movie/Recorded from satf

e — [ — ————— . T 2=

Press the green button (OK) to save, then do this procedure one more time for the
"Timeshift location" > before exiting the "Recording Paths" menu - - green button to Savel!

Voilal Sorted the E2structure/devices according to your specific needs! Moreover, while
doing all this you will understand it all better and remember what goes where, so all's good...
That is mostly - it! Last remarks in this section...

Service searching is advisable, o get a more updated channel list. It's simple, just let it
search through all your satellites, overnight, then press OK in the morning and EXIT...

Try finding Reinhardt's xml file on the net, with up-to-date list of transponders to scan, if
you're not sure the scan will get all the channels, via network scan option being “on" etc....

Service scan 09.Dec 9152

Manual Scan

Tuner Tuner & Conexant CXZ4116/CK24118 (DVB-52)
Type of scan Multisat
SIRIUS 4.BE EE
EUTELSAT 7.0E enable
EUROQEBIRD 9.0E enable
EUTELSAT 10.0E enable
HOTEIRD 13.0E
EUROBIRD 16.0E
ASTRA 19.2E

THOR 0.8W

Hetwork scan

Clear before scan

Only free scan

Softcam will be controlled via PB Centre, not in this menu.. We'll come to it later...

SW update is used occasionally and there's nothing fo it. But if you haven't updated for a
while, activate the SWAP file, as discussed above, if you suspect there may be many updates.
Also, there is another similar function in PB Centre, directly connected to PB Team, the
writers of this specific E2 flavour! Go to: blue button > PB Centre > PB System Setup >
Classic System update = when done, press OK - EXIT - Restart GUI (in PB Centre)!
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8) Let's install stuff galorelll

Now, we can continue doing the really cool stuff, since we “"expanded” the flash, hehe...

Earlier I mentioned the awesome support of PB Team. Well, it's all in the wrist, lads and
gals! With a flick of a button, you get to the good stuff that makes this hobby so interesting!

First, let me tell you: a long time ago, when I used a PB E1 in my old DBox2, for the very first
time, this was the sweetest part - a revelation!ll Easy to use and really well sorted out, good
quality support server from which to download and install all manner of things, directly into
your box, without the need to mess with it all manually, via FTP and Telnet etc. Very, very
coollll And if you have a clone - these are safe, since checked and sorted out beforehand!!!

We have quite a few plugins and other stuff to choose from (so they had fo be divided into
sub-sections: system plugins, cams, settings, skins, extensions etc.), to download/install
straight from the PB server, then configure those to serve our needs... Where shall we start?

Press the RCU blue button > PB Centre > AddOn Manager > Bob's your uncle, heheheeeee...

Powerboard AddOn Browser 09.Dec

systemplugins
drivers
private

skins

picons

module

[
Ed
[
[
[
[

Installing directly from PB server/net

Just so you know: these lists keep changing, as PBNIGMA keeps changing, plugins get better
or worse, sometimes they stop working with a new image etc. If you can't find it here - and in
another place I will cover shortly - internet is your friend!

To install or uninstall something from these lists, one simply presses the OK button, once
you scroll to a plugin > just confirm and when "Done" - OK again. Voila! Best advice is to
"Restart GUI", after each installed plugin! Do it slowly - be safel!

Green dot means "it is already installed in E2" and a blue dot means that there is an update
for it available. Red dot = "not installed”.
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These will be my choices/an "example”, which you do not have to agree with at all, of course...

Settings: I get a channel list from the net/good forums - and it is only a base, which I
then re-do, according o my needs, as I mentioned earlier. If you have a simpler setup,
one of those offered here might be completely satisfactory...

System plugins: here, I only uninstall cablescan and wirelesslan, as it is not possible to get
crossepg nowadays, from this section of PB AddOn Manager.

Drivers: usually for new HW, like USB DVB tuners, cable or terrestrial.. If you have one of
those, new ones, not included with E2, then here they may be. Also, USB serial drivers for
USB smartcard readers, I presume...

Private: nothing much here...

Skins: One Key Blue is great by me! If one would have thought that I am undemanding in this
department, one would be wrong! It has Pi6 (Picture-in-Graphics), so when you're browsing in
the channel list you still see your TV screen! It also has integrated ECM info at the bottom
of the screen, which works fine with CCcam and OSCam that I use.

And just generally speaking, it has a great balance - between scarcely any info and way too
much infol I.e. only the essentials, hence not overwhelming the screen with superfluous info,
like some other skins or everything one can think of being put on the TV screen...

Alternatively, when I feel like ‘maximum info', I would go for HD Glass skin, with heaps of
stuff right up in your face and zillions of options to play with - but slowdown is possible, then!

However, HD Glass is in extensions section, nowadays and not here, strangely...

Picons: those are small TV channel logos, to identify a channel by and make it all a tad
funkier, hehe... They should show in your skin, next to the name of a programme that is on.

One can also find them on the net, put a whole bunch of them together (some 60+ MB), thanx
be to those who collect them and send them to the box manually, as mentioned before (FTP)!

If you're going to use HD Glass skin, loads of them are already included in it, so you do not
need those put here. I might cover this in the next guide version, if I find the strength...

Modules: specific stuff for experts, to put into kernel itself - leave this be...

Extensions: this is the most populated section and some of the most important stuff is here!
For instance, cccaminfo - if you install CCcam - if one needs more info than OneKeyBlue,
OpenPLi HD and HD Glass skins show; cooltvguide - presents TV programme/film info and EPG
really well; dreamexplorer - like Windows Explorer, with capacity to execute scripts;
dvdplayer - to play DVDs or DVD folders on an HDD; enhancedmoviecentre - for extra info
about films etc.; mytube - obviously.... oscamstatus - obviously...; quickbutton - to assign
various functions to different buttons, according to your preferences; various
passwordchanger extensions- for an obvious purpose... etc. efc.
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Here's a little peek into the menus:

Powerboard AddOn Browser 09.0ec 11:05

Installed package version: 1.3-m

g dreamexplorer_7.3

e wersion: 7.3

client o

Play rtp Stream
Package wersion:

Installed package version: 2.7 +git10400+bf 16001 -rd2
..and a little later...

Powerboard AddOn Browser 09.0ec  11:47

openuitzendinggemist
extensions-openuitzendinggemist
Tan: 1.0+gitMone-rd

orfat
Ltreaming modul
Package wers
orfteletext
0 etk
wrslon: experimental.git3T 95 +41$habd-r7

oscamstatus

en
+41%betd-rT

Security - firewall, if you really need one...;
PLi - softcamsetup is not really needed, as it is handled by the PB Centre;

Camd: cccam 2.1.3 (T use this one, when I use CCcam, as it is working well with keys,
allegedly better than other, esp. latter versions), cccam config, oscam 1.10 (an older but
stable version, if it works with your smartcard), oscam config slot 1.

By the way, you can update components one by one, in this section, so you have more control...

One can also add more stuff, from Main Menu - Plugins > Download plugins, where Red
button will remove a plugin and green will give you another menu to choose from a list...
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Installing from Plugins

Plugin browser

AutoBackup
id

tings backup

nfo vi.3c

e stabus of your Dhcam

DVDPlayer
Play D¥Ds

m-Explorer
ur Oreambax.

Some of the plugins are already in this menu from the previous set of actions but some are
just here, in this section. Let me demonstrate on a specific plugin, which sports lovers would

appreciate a lot, I think..©

However, here we are interested in Software Management plugin:

Plugin browser

Oscam Status
hals gairg anT

o Picture player
Ui L aren | fileformats (DM, FRG, JFG, GIF)

I | Porn Center
|m‘| Adult straaming

P rboard-Center
Proever boar d-Panel

r AmBIDSdmEBID0

We get this menu and go to Advanced options at the bottom of the list:

Softwaremanager

Software Update

Software restore

Backup system settings

Restore system settings
Install local extension

Advanced pptions

09 . Dec 12:29

Manage extensions or
plugins for your receiver
Press OK on your remote

contral to continue,
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We choose Packet Management:

Softwaremanager

Advanced restore
Select backup location
Select backup files
View, install and remowve
available or installed
packages.

Press OK on your remote
control to continue.

PacketManager 09.Dec  12:34

enigmaz-plugin-extensions-shoutcast
enigma2-plugin-extensions-showclock
enigmaz-plugin-extensions-simplerss
enigmaz-plugin-extensions-snmpagent
eni gmaﬂ--plugin -extensions-socketmmi

One must spend some time here, searching and enjoying the hobby... Chillax, it's good funl
When the globe next to a package is coloured - it is already installed, of course!

You will find various alphabets for various languages ("local..."), many different kinds of files
for certain plugins, like 1Channel ("subprocess” for python2.x), more settings lists, more
skins, and a lot, lot more - see if you can find it here, with some patience... ©

PacketManager 09.Dec

python-sglite3-tests

python-stringold

python-syslog

python-terminal

python-tests

python-textutils
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HD 6lass skin is hiding here, for instance, not where most skins are:

PacketManager

igmaZ-plugir
enigmazZ-skin-blueshadow
enigma-skin-dmconcinnity
enigmad-skin-essentialfz
enigmad-skin-hdglass16
enigmad-skin-skincomponents

enigmazZ-skins

Like above, you can also uninstall a component, the same way you're installing it...

One more function that is similar is in PB Centre > PB System Setup -> Expert Installer,
where all this is organised alphabetically, albeit not in English alphabet, hehe... But because it
is broken down in smaller sections it will be easier to go through all of them. You will be able
to perform similar tasks to the just explained manner of doing things in this section...

I also add stuff manually from my PC, like CrossEPG, if it is not included in PB Centre,
DDsubtitle Player by Damir and 1Channel, film streaming plugin direct from the net, by my
young and promising colleague Subixonfire! Here is an example of how that is done...

Installing an “.ipk"™ package

Get a file on the net, transfer it from PC to F500 HD. Use FileZilla Client to do that, as
explained above, in section 5. Transfer the .ipk file to PB VX IT's /var/volatile/tmp folder:

site: | fwar feolatie fimp - I Filemame
[ 2 cache - | i
P empty camdinstall
B et lchannel-e2_ 0.9 prerelease_allipk
z ::"’r‘ camd.socket
~ ecm.info
; :::EI ecril.info
2 log enigmal-plugin-extensions-subtitleplayer_3.09_mipsel.ipk
B enigmad-plugin-systemplugins-crossepg_0.6.2+git27T4+ 3¢
B coce | L hotplug.socket
2 spool | Seh] screenshot.jpg
£ tmp
wiolatile
cache
lock
leg
+ run
tmp

¥ =
camdinstall

— :E files and 1 directory. Total size: 1,639,475 bytes
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As you can see, I transferred 3 .ipk files that I want to install to F5EOOHD with PBNIGMA!

Press the Blue button on your RCU - PB Centre - choose IPK-Installer:

PowerboardSystemSetup

€

Satfind

L

Classic Systemupdate

&

:
il

PB-DeviceManager
PB-Backup-Manager
PB-5etEPG-Path
PB-SetPicon-Path

PB-KernelModuleManager

You will get this window, if the file is in /var/volatile/tmp folder of your PBNIGMA VX II:
Selection Screen

Select IPK-File please!

1 enigma2-plugin-systemplugins-crossepg_0.6,2+git274+3eb635ee-r0_mi
2 enigma2-plugin-extensions-subtitleplayer_3.09_mipsel.ipk

Choose one of them by pressing the OK button to install it:
Message

install /tmpf1 channel-e2_0.9_prerelease_all.ipk ?

Confirm it:

Execution Progress:

Downloading http://www.pb-download. com/o 2/dm500hd 1 pli/Packages.gz.
Inflating http:/ W. pb-download. com/ou/ m500hd_f_pli/Packages.gz.

Updated list of available packages fvar/l :-"':_lFrh.E.-"P[!- Powe rboard .
Downloading http://www.pb-download. com/ou/E2/extra-giga/Packages.gz.
Inflating http: i . pb-download. com/ou/E2/extra-giga/Packages.gz.
Updated list of awvailable packages in /var/lib/opkg/Powerboard-Extra.
Installing lchannel-e2 (0.9 _prerelease) to root...

Configuring lchannel-eZ.

Execution finished!!
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When it is done, in PB Centre - Restart GUI, so the plugin becomes available. You will then
need to configure it, like with any other plugin installed like this, before using it...

9) Let's configure this "stuff galore”!

Sure, now we can install loadsa stuff and we do not have to worry about installing too much...
But we must worry about configuring it properly!

First, T will write about the one we just installed, then about two of the crucial ones for our
needs ("cams") and then about CrossEPG and Subtitle plugin by Damir, some of the best
plugins for E2!II

Configuring 1Channel plugin by Subixonfire

So, after reboot, we get this screen in Plugins:

Plugin browser 09.0ec  16:18

Au dio Sync Setup

wetup for the Audio $ i Plugin

|E m AutoBackup
Autamatis ETIrI’ kg

1. 3c

T||| plugin sha vou Lhe status of vour CCcam

DYDPlayer

| eruin ) Play DYDs

Since I already installed “subprocess” file for Python 2.6, which is the version used in this
PBNIGMA (see above), and since I already made 1ch folder on my HDD (used for
"buffering” - see below)...

Remote site: | [mediafhdd * | Filename
il efc /1ch
-2 hdd backup
-
d _ | movie

=~ 1., media .
5 rr7u5|c
+ w | picture

..we can fry fo stream something from the web...

Like a film, randomly chosen, just to see if it works...
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1channel

Movie
Tv Show

Userlist

Kill all downloads!!!
Help & About

Exit

1channel

We choose, say, A...

1channel (green button Subtitle player)

A linglementary Looking Beneath the Balls {2008)
A Married Couple (1969)

A Moment of Innocence (1996)

A Morml Life (2011)

A Special Presentation Oprah and Elie Weisel at Auschwitz Death Camp (2006)
Agnes of God (1983)

America and the Mot time

Assassination in Rome (1965)

A" gai wak (1983)

-- And Now the Screaming Starts (1973)

...and an the 7th Day, God Rocked (2008)

A Bag of Hammers {2011)

A Barge and Its Wind (2010)

A bear named Winnie (2004)

A Beast at Bay (1912)

4 Beautiful Life (2008)

Then, where to stream it from..

1channel

[ ed at! PUTLOCKER

Videa hosted at: PUTLOCKER

Video hosted at: PUTLOCKER
Video hosted at: SOCKSHARE
Videa hosted at: SOCKSHARE
Help & About

Exit
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..aaaannddd... after some buffering (patience!)...

America and the Mob Wartime Friends (2004) 09.0ec  18:28

43:52

Moving on, to CamDs ("Emulators”) of greatest importance, for most users...

OSCam stable 1.10, with DVB APTII

OSCam is installed easily from the PB server, including the configuration files, as described
above, with a single push of an RCU button.. (v. 1.10 and a 1*' slot configuration files).

OSCam (with DVB API) is both server and client, so ho other cams are needed!
There are three main configuration files. One must edit them according to one's needs!

1) oscam.conf, user and server files are in etc/tuxbox/conf folder, with oscam.dvbapi,
oscam.tiers, oscam.provid, oscam.services (find the details for your smartcard on the net)

2) OSCam_1.10 module is in> usr/bin/cam (- CHMOD to 755 [right-click on the file > File
permissions - 755 > OK], if you're FTP-ing it o PBNIGMA VX ITIl)

3) script oscam_1.10.sh is in /usr/script/cam (> CHMOD to 755 if you're FTPing it to E2)

One can make these files with Notepad++ > Copy and Paste the content info it > edit as
appropriate for your card - Save as > (bottom drop-down menu) All files > name it - Save.

OSCam configuration file is used to sort out the main, global functions and o make a part of
your N or C line.

For instance, that you prefer your local card over ones on the net. Or how to control
OSCam via WebIF (get info your OSCam settings using your internet browser). If you are
using your card reader, with Original Smart Card (OSC) in it, so your subscription takes
precedence and you can share it with your colleagues/peers, plus using which protocols and
how exactly...
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oscam.conf

[global]

Nice = -1
ClientTimeout = 5
BindWait = 60
LogFile = stdout
CacheDelay = 120
preferlocalcards = 1
waitforcards = 1
saveinithistory = 1

Ib_mode =1
Ib_save = 100
[webif]

httpport = xxxxx

httpuser = xxxxxxx

httppwd = xxxxxxxx

httpallowed = 127.0.0.1,192.168.0.0-192.168.255.255
httprefresh =5

[dvbapi]

enabled = 1

au=1

user = local_user
boxtype = dreambox

[newcamd]
key = 0102030405060708091011121314
port = xxxxx@0B00:000000

[cccam]
port = Xxxxx
reshare = 3

ignorereshare = 0
version =2.1.3
updateinterval = 240
minimizecards = 0
keepconnected = 1
stealth =1
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The following file is used to setup various readers/servers, including your own (i.e. both
“local” and those of your peers, used/connected with over the internet), i.e. OSCs to open
various channels with...

oscam.server

#my internal card reader and server, with local card

[reader]

label = your_subcription
description = whatever_you_like
protocol = internal
device = /dev/sciO
group =1

emmcache = 1,3,2
detect = cd

caid = 0BOO

ident = 0B00:000000
services = CD Sweden
cardmhz = 357

mhz = 500

#external CCcam readers = my peer's servers, group 2

[reader]

label = xxxxxxx

enable = 1

protocol = cccam

device = xxxxxxxxx.dyndns.org, xxxxxx
user = XXXXXXXX
password = XXXXXXXXXXX
Ib_weight = 100
reconnecttimeout = 30
audisabled =1

group = 2

cceversion = 2.1.3
cccmaxhops = 1
ccckeepalive = 1
emmcache = 1,3,2
fallback = 1

[reader]
etc. etc.
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In the following file, one sets up users of your smartcard/subscription, including yourself!
Here, you give permissions to use your card/your own reader/server, among other things, by
placing users in different groups, depending on what you want to share/use...

oscam.user

#my local account

[account]

user = name_it

group =12

au=1

services = all

monlevel = 4

betatunnel = 0300.FFFF:0100,0400.FFFF:0100
keepalive = 1

#my peer's, external accounts

[account]

user = XXXXXXXX

pwd = XXXXXXXXX
group =1

uniq = 40

au=0

caid = 0BOO

ident = 0BO0:000000
monlevel = 4

[account]
etc. etc.

In the second account: this is for an N-line. In that case, you are only sending the original
card and nothing more, like the stuff you might be getting from your "peers”, if you have
their permission for re-sharing their card(s).

If you are sending a C line with everything you are getting from your peers, then put
“services = all".
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The following one is used to start and stop OSCam.

oscam_1.10.sh

#1/bin/sh

OSD="Oscam_1.10"
PID="pidof Oscam_1.10
Action=$1

cam_clean () {
rm -rf /tmp/*.info* /tmp/* tmp*
}

cam_handle () {
if test-z "${PID}" : then
cam_up;
else
cam_down;
fi;
}

cam_down )  {
killall Oscam_1.10

sleep 2
cam_clean
}
cam_up () {
/usr/bin/cam/Oscam_1.10 -c /etc/tuxbox/config &
}
if test "$Action" = "cam_res"; then
cam_down
cam_up
elif test "$Action" = "cam_down" ; then
cam_down
elif test "$Action" = "cam_up" ; then
cam_up
else
cam_handle
fi

exit O
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It should work, if you put in your subscription's correct details, plus your peers' details,
provided OSCam can work with your subscription card. It works with so many!

Restart GUI, then - blue button - PB Centre - Cam Manager - start OSCam 1.10.

Don't forget to do the port forwarding in your modem/router, if you wanna be a server!

DreamCC

- Exit button and wait for the picture, if all was done correctly. Maybe change a channel...

OSCam Info plugin
Use this plugin for OSCam, like you would CCcam Info for CCcam (see below).

Oscam Info - Main Menu

} Shew Log
Card Infaz [CCeam-Rasdar|
ECM Statistics

" Restart Reader
Setup

% Show readme.txt

Configure it in MENU - Plugins > OSCam Info > Setup.
Put the port, username and password details from webif (oscam.conf). Green button to save.

Oscam Info - Configuration

Cancel Ok

IP-Address

Part

Username (httpuser)

Password (httpwd)

Automatically update Client/Server View?
Update interval (in seconds)
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CCcam - an easy rider...

If one can't or doesn't wish to learn or if one has no time or good will or if one feels insecure
or... I don't know... has some kind of an OSCam-allergy, hehe...

The one advantage over OSCam is - it works with all kinds of publicly available keys for the
publicly available, hacked systems of encryption (unless you use a specially modded version of
OSCam). I shall describe how to easily get them straight into your machine, from a server...

CCcam: Emulator, Card Reader, CS Server and Client

I will presume you followed my advice from the PB Centre section, i.e. that you have installed
the CCcam config files - from the same PB-Centre Addon sub-section. In that case, you will
have a fully functional CCcam 2.1.3, with a minimum of fuss/subsequent editing!

In the /etc folder you will see CCcam configuration files, like CCcam.cfg.

As most of you know, one can read all the instructions in the file itself, which is loaded with
explanations/comments!

So, one puts one's F (to be a server), C and N lines (o be a client) in the CCcam.cfg file.
Restart.

After that go to blue button > PB Centre - Cam Manager and give the command to
"Start/Restart" CCcam, using the green button (see image above).

Warning: if you are going to be a server, don't forget to open the correct port(s).

For much more info, on this and many other subjects related to CS, see the 11™ part of this
guide (Appendix). Especially newbies, in need of more detailed info about its inner structure...

There, you will be able to read a lot more, in order to understand Emulators, CS SW etc.
Also, about configuring other equipment and which tools to use for it etc. etfc.
Script to get the keys from the net, straight into CCcam

If you are going to use the emulator part of CCcam, i.e. the publicly available keys of hacked
encryption systems, then you will need the files for it, plus edit the CCcam.cfg file to put in
the correct path to direct CCcam to them (/var/keys, in F500 HD with PBNIGMA VX II).

One can get them from various good forums or via a script called...
TechSatKeyDownloader.sh

1) Make the TechsatKeyDownloader.sh file from the following text, as described above:
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#! /bin/sh
#DESCRIPTION=This script Download Softcam by TeChSaT Team

umask 022
clear
echo " TechSat Team"

echo " Contacting server. Please wait..."
echo nun

wget http://satlab.techsat.info/Maker/CCcam/SoftCam.Key -O /tmp/SoftCam.Key
2>/dev/null
wget http://satlab.techsat.info/Maker/CCcam/constant.cw -O /tmp/constant.cw 2>/dev/null

if [ -s /tmp/SoftCam.Key -a -s /tmp/constant.cw ]; then
echo " Softam files downloaded succesfully! Installing..."
echo ""
mv -f /tmp/SoftCam.Key /usr/keys/SoftCam.Key
mv -f /tmp/constant.cw /usr/keys/constant.cw

else
echo " Download failed! Try again."
exit 1

fi

echo " Softcam files installed succesfully! Enjoy!"

echo " "

echo ""

echo "For Info Channel Key. Please Wait...."

echo ""

sleep 2

wget http://satlab.techsat.info/Maker/CCcam/TechSat.log -O /tmp/Changelog_info.txt
2>/dev/null

echo
cd /tmp

sed -e 's/ //g' Changelog_info.txt > output.txt

grep -v '"$' output.txt > outputnew.txt

cat /tmp/outputnew.txt

rm /tmp/Changelog_info.txt /tmp/output.txt /tmp/outputnew.txt
echo " !

echo ""

echo " Powered by TechSat Team - http://techsat.info/"

echo ""
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exit O

2) Save as "All types”, with the name I gave above (TechsatKeyDownloader.sh).

3) Use FZC to FTP the file to PBNIGMA VX II, to /usr/script/cam - CHMOD to 755.
Restart GUIL.

4) When E2 is up again, go to: blue button > Dream-Explorer - usr - script 2> cam >
TechSatKeyDownloader.sh > OK - Start execution > EXIT when done.

5) Check that you have the keys, by using FZC - FB500HD -> usr/keys.

6) The proof of the pudding is in eating! Go to HotBird @ 13°E (the satellite everyone has)
and find TV Globo, which should work with those keys you just got from the net, hehe...

7) Blue button > CCcam Info > it should say "Using: Emu"!

8) If this doesn't work, one can still get the keys at the address in the script:
http://satlab.techsat.info/Maker/CCcam/TechSat.log - put them into SoftCam.Key file
you will find on the net and FTP it to PBNIGMA VX II, manually...

CrossEPG

Need Electronic Programming Guide? You will need this plugin! (Btw, it doesn't always work!)

Not all providers are sending EPG with the pretty pictures they are sending to us... So, T
installed the CrossEPG as an .ipk package. Get it here:
http://code.google.com/p/crossepg/downloads/list When done - Exit button - Restart GUL.

Try various versions! Keep your nerves in check - it's not 100% operational with all images!
Configure CrossEPG
According to your needs: MENU - Setup = CrossEPG

CrossEPG - 0.6.2 (svn 306)

# Configure
P MMLTVY providers
& OpenTV providers

3DB providers

E Scripts providers

£\ MHW2 providers

= Providers start arder

. Update rytec providers
Update xepgdb providers



http://satlab.techsat.info/Maker/CCcam/TechSat.log
http://code.google.com/p/crossepg/downloads/list
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First, go fo > Configure, fo setup where to send the subtitle files you are going to download,
when you will do this, if it's going to be automatic (and when) etc.

CrossEPG - Configuration

Storage device
Enable csv import

Force epg reload on boot

Download on tune no
Scheduled download once a day
Scheduled download at 46T
Show as plugin 3
Show as extension

Show ‘Force reload as plugin

Drive where you save data,
The drive MUST be mounted in rw. if you can’t see your device
here probably is mounted as read only or autofs handle it only in
read only mode. In case of mount it manually and try again

Back el

- Exit RCU button. Now, choose XEPGDB and other types of files for various providers!
Some formats are quicker to download and load to your USB memory than others... Test it...

CrossEPG - XEPGDEB providers

Devileosta Mova English XMLTV [XEPGDE repacked|
2 0% 0 (XEPGDE repacked)

Krkadoni E i d)

Linuxsat ExUSSR XMLTY [(KEPGDE repacked)

Rytec Benelux AMLTY (KEPGDE repacked)

Rytec Bulgaria XMLTV (XEFGDE repacked)

Rytec Denmark XMLTY [XEPGDE re packed)

Rytec Eratic XMLTY (XEPGDBE repackad)

Rytecs Finland XMLTV [XEPGDE repacked|

Rytec France ¥MLTY (XEPGDE repacked)

Rytec Germany/AustrlaSwlss KMALTY (XEPGDE repac
Rytec Greece in English KMLTY (XEPGLE repacked)

Back Dizable O paemilead

We should now check if we are sending the EPG files to /media/cf and /media/cf/crossepg
folders by going to PB Center > PB System Setup > Set EPG Path. Make sure, as T wrote
already, that all those places where you direct those downloads are "“in sync”...

Get out of that menu and go to Restart GUI!
You are now ready to...
...download the EPG and all should function well: blue button - CrossEPG Downloader, > OK.

A little bit of patience and when it's done > Restart GUI! (If you're lucky it might work!)
After that, check the EPG by pressing the Info > /blue RCU buttons. If it works -
great! But I have to say I am having problems with it. At least with this image, I do...
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If it does work, then one goes to blue button > Cool TV Guide and one can see a lot more...

If one installs MultiQuick Button plugin, one can assign a (coloured) button of one's choice to
Cool TV Guide function, for instance. Once in Cool TV Guide, if you want to see more channels
in the list, press the RCU button.

At this point, one must investigate further the EPG possibilities in connection with what one
has in PBNIGMA VX IT now, and then arrange it according to one's needs, of course.

If everything slows down considerably - try restarting it properly, not just the GUI...
DDamir's Subtitle Player tutorial, thanx to Zupy

No point in re-writing a good guide for the plugin! It's here:
http://www.krkadoni.com/log/forum/index.php?topic=144.0

Download it here: http://www.krkadoni.com/log/forum/index.php?topic=189.0

One of four best ever written plugins for E2, IMO!

However, it could be better! To my mind, it lacks playing subtitles from any folder easily, i.e.
to start searching from the folder where the film itself is, if one is streaming from an HDD,
NAS or PC. Also, effective syncing with a film - at any moment. It should instantly sync the
time played with the time indicated in the subs file. Some OSs can, so why not this plugin?

1Channel and DDsubtitle player working together

If you have installed DDsubtitler 3.09, the first thing to do is to update it to v. 3.18, from
within the plugin itself. Press "0" on RCU, when you are in the main menu. Repeat it, after
reboot, to updated it yet again, to v. 3.23 (at the moment)!

Configure DDsubtitler according to your HW setup. My subtitle downloads are going to
/media/cf/subtitles. You will see how to do it, in the main DDsub menu - coloured buttons...

Start 1channel plugin, find a movie you wanna watch and at the top of the window you will
see a message to press the green button. DDsubtitler starts and at the bottom of the
window one can see the title of the film you have just found in 1Channel and want to see.

Press the green button (download) and various subs for the film are offered. Choose the
one you want and it will be downloaded to your preferred location. Exit DDSubtitler. One
returns to the previous menu in 1Channel plugin now, where one chose the name of the film.
Start the film (by pressing OK and choosing the service from which to stream). Now, you
need to go back to DDsubtitler: press MENU on RCU - Plugins - DDSubtitler - blue button
to start the already downloaded, ready to watch subtitle file. Now you need to sync the
video & audio, by pressing the four (arrow-like) buttons around the OK button. Enjoy!

A big thanx to Damir, Subixonfire & Grle for the tips!ll Very cool - their help saves valuable
time - kinda like this guide to you, hehe... ©


http://www.krkadoni.com/log/forum/index.php?topic=144.0
http://www.krkadoni.com/log/forum/index.php?topic=189.0
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10) Streaming

As you read above, I have an external, USB HDD attached to my F500HD.

Also, I have a couple of laptops and Synology DS210j NAS attached to my router, just as my
F500 HD is attached to the router. They should all, therefore be able to "talk". So, let's talk
streaming "multimedia” and Multi Media Centres.

It is good, it seems to me, to have already sorted out the USB HDD before this...

Prepare the Home Network

I made them all a part of my WORKGROUP, of course. One ought to configure each device, so
they belong to the same WORKGROUP. You can name your WORKGROUP any way you want to
name it... Allow each other's access into each machine's firewall, if any!

Then, one must prepare to stream from PC/laptop to F500HD with PBNIGMA VX II, by
making various folders "visible” to PBNIGMA. I.e. one has to make those folders "shared
folders" and a few more things... Only then can we go to sorting it out in F500 HD.

In accordance with the above requirements, I did the following, in order to "mount" the
movie, music and photo folders in my NAS and laptop's fo my Ferrari, so Ferrari can "see"
those files and my NAS can stream them, viamy home network ([W]LAN) to Ferrari...

From NAS to MMC

1) On Synology DS210j [my cool Linux-based, really well sorted NAS], I created shared
folders [video, music, photo].

2) Then, I activated the NFS sharing protocol in DS210j settings [Linux streaming protocol,
as opposed to Windows, CIFS].

3) In the NAS I also created a user I called Ferrari [including the password]. Otherwise, all
else is done from the main admin account, with its password. One needs to give rights to the
Ferrari user [Write and/or just Read, according to what your needs are].

4) Each Shared Folder must be edited for > NFS Privileges. Here, I gave them to my
F500HD, in the form of its IP address [192.168.x.x].

Even though I have an account with username/password to log in - those aren't necessary!
The Shared Folders, once again, are video, music, and photo.

Now, we shall prepare a PC/laptop, with various Operating Systems, for streaming from
them!
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From PC/laptop to MMC

I'll only cover three various flavours of Windows here...
How to stream from PC with XP to MMC

Start your Windows Explorer - go to the main folders or even whole partitions you want
shared - right click on them - Sharing and Security, then give them the rights > Allow to
be shared. Also, > Customise > Apply the template to all subfolders > Apply > OK.

Then, just in case, I went a bit "lower" and repeated the whole thing to the Music, Video and
Photo folders, one by one, and - lo & behold - NTFS or not, firewall or not, who cares - all the
movies and other media files are playable, in F500 HD, via Media or DVD Player!

Streaming from PC with Vista to MMC

On your PC/laptop: go to Start >Control Panel - Programs and Features - Turn Windows
Features on or off > here I added/installed anything even remotely connected with
whatever I need to use for multimedia streaming [Telnet Client, TFTP Client, Services for
NFS...], since lay-people like me cannot know exactly what's what in there, hehe...

Start > Control Panel > Network and Sharing Centre -allow:

Network Discovery
File Sharing

Media Sharing

So, those to ONI
The rest to OFF.

At the bottom of that page click on "Show me all the files and folders I am sharing".

Now, go to a partition or a folder or a file you want to "share" - right click > Properties >
Sharing > Advanced Sharing - Share This Folder > Permissions - Everyone [only "Read" is
enough, from all the options there] - Apply > OK.

Security - Everyone.

Customise > All items > choose/tick "Also apply this template to all subfolders" > Apply >
OK or Close, whatever's there...

Streaming from PC with Windows7 to MMC
I first went o Windows7 components and activated everything network related there:

Start > Control Panel > Programs and Features - Turn Windows Features On or Off >tick
the Media Features, Network stuff, Telnet Client, TFTP etc. > OK.
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Next, go o Start > Control Pane\All Control Panel Items\Network and Sharing Centre >
click on Choose 'Homegroup' and sharing options - choose the folders o share. Tick the
option to "stream your pictures, music and videos on my home network".

Click on Change Advanced Sharing Options. You are in Control Panel\Network and
Internet\Network and Sharing Centre\Advanced sharing settings:

turn on network discovery
turn on file and printer sharing
stop the "Public Folder Sharing".

Go to > Control Panel\Network and Internet\Network and Sharing Centre\Media streaming
options > Media Streaming Options > Name your media library [your nick, for instance].

Show devices in the local network > Allow all
Media programs etc. etc. > Allowed.
Go back [BACK button]:

leave the 128b encryption to on
turn off password protected sharing
allow Windows to manage homegroup connections.

Then, start your Windows Explorer and

find all the folders you want to share;

right click on each folder and go to Properties;

click on Share tab > click on the little arrow downwards to get the drop down menu and
choose Everyone, then click on Add.

Give "Everyone" the permission o READ ONLY and click on Share.

You have more controls/options under Advanced Sharing button. Go to it and check the
permissions etc. When you're done, in the main Properties little window, finish by clicking on
Apply and Close.

Reboot your PC or at least reboot your Ferrari (sometimes both is needed) and try finding
your PC and the folders to stream from. Normally, one needn't reboot F500HD, mind!

Mounting shared folders in MMC using NB/MM plugins

There are two ways of mounting shared folders from "networked devices" ([W]LAN) to your
MMC/F500 HD:

1) Using NetworkBrowser/MountManager plugins or

2) Using fstab editing.
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For the former: press the MENU on RCU to get to the > Main Menu > Setup > System
> Network = NetworkBrowser. Don't worry, I will repeat some stuff from above but

it'll make it easier on you, so you don't have to go back to find the relevant parts of the
"guide”.. ©

Make sure all your multimedia devices are fturned on.
The plugin scans your Home Network and gives you what it finds in the list.

Choose your (Linux) NAS and you are supposed to see all of its shared folders, which you
now need to “activate” and "mount.”

Choose one and it will ask you if you want o enter a username and password for this host.
Choose "no"! Then, you will see the list of all the folders it found. Pick one.
Network Neighbourhood

“U° 192,168, DEE— )

% Svolumel/! s

& Svolumet/ E—

| am 192160 —

W volumed,
e A 19216z, EEEE

Press OK to mount this
share!

% Svolumeds I
LR ER R p—

. Svolume,) I
B e 19 158 —

MountEdit 05.0ct  01:13

e enakble
Lecal share name - vid
Mount type HFS share
Server IP 192188 :
Server share feolumets
use as HDD replacement no

i v Mount options rw,nelech top
Press OK to activate the R

settings.
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Active & Enable.

Local share name - give it a name that will describe which machine it is and which shared
folder it is (for instance, NASvid, NASmus, NASphoto or PCvid, PCmus or PCphoto).

Mount type > NFS, if your machine is Linux based (like my Synology NAS 210j) or CIFS
share, if your PC/laptop/NAS has Windows as its operating system.

Server IP - 192.168.x.x (local network IP address of your NAS or PC).

Server share - it has two slots, divided by the forward slash (/) sign (my NAS/NFS
shares require both slots but my CIFS/laptop shares require only one slot = the name of the
folder itself): NFS/NAS example: /volumel/video and CIFS/PC example: /VIDEO.

Use as HDD replacement - no.

Unless you want to record to your NAS or PC over the network, in which case choose
"yes" > where your box will be recording by default (in Setup = Record path
->/hdd/movie will be that folder).

Mount options > leave it as it is (rw,nolock,tcp)
Press OK on RCU to save the "mount".

Note: username and password in User management are not needed, if you did what I did in
the beginning of this part of the guidel

You must repeat this procedure for each shared folder on any machine with shared folders
you want to stream from.

You can check if the folders are both mounted and active by going out of NetworkBrowser
and choosing MountManager ->Mountpoints management, where you can edit or delete
them.

Where to find those folders in E2?
Well, if all goes to plan, all of those "Mount Points" can then be seen in 2 places:

1) Media centre > choose My Videos (or Music or Pictures) - here, one is given various
options, depending on what one has attached to F500HD:

-Internal Flash,

-HDD or

-USB stick and then follow

-all of those shared folders mounted by Mount Manager plugin, from either your NAS
or PC/laptop,

but also
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2) under: Internal Flash > media > net > they are all there as well...
Normally, we can choose the recording path, like the picon or EPG path.

However, if we do this via the plugins, the default path is changed and directed to the
NAS partition of your choosing by choosing the partition as "HDD replacement”lll

Therefore, the advantage of this approach, is that the default /hdd/movie folder (to record
to) will now be on the NAS, if you choose the option to use at least one of the shared folders
on the NAS as an "HDD replacement"! HD channels might not record correctly over the net...

Mounting shared folders in MMC by editing fstab

I learnt, thanx to Manolito's help, how to mount NFS shares from my NAS by editing the
fstab file, which is in /etc folder of E2. That is quite an elegant procedure.

For my NAS/NFS shared folders it looks like this: create folders (I make three: filmovi,
muzika and fotke folders) in /media/net/, where you will mount your NAS shared folders.

This is the syntax for NFS, if anyone needs to mount a Linux-based NAS:

192.168.x.x:/volumel/video /media/net/filmovi nfs nolock,rsize=32768 wsize=32768,intr
192.168.x.x:/volumel/music /media/net/muzika nfs nolock,rsize=32768 wsize=32768,intr
192.168.x.x:/volumel/photo /media/net/fotke nfs nolock,rsize=32768 wsize=32768,intr

-192.168.x.x = NAS IP address

-volumel/video = the path to the shared folder with movies I stored on my NAS
-media/net/filmovi - folder o mount it to, in your FBOOHD with E2

-nfs = type of protocol used by my Linux-based NAS

-the rest is standard, re. the data transfer limit.

This reduces the need for plugins and thereby simplifies E2, making it lighter, faster and
more stable. If you mount a USB HDD beforehand, then this is cool to do for NAS.

From MMC to PC/laptop
Want to stream from MMC to laptop/PC? How?
Using Webinterface plugin (see Plugins to configure it)!

Web Browser = write MMC's IP address:80 = http://192.168.x.x:80 = Enter

This is what you'll see:



http://192.168.x.x/
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AZBOX WEBCONTROL
TeleWision Radio Movies

HRT-TV2 - Nodni glazbeni program: Glazbeni sp<

TekeVision
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Provider
All
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19 yR & Ex YU
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. 19 ADULT 00
W pDEUTSCHLAMD FTA

EFG. Scomch = rraLY FTA

SaiEhERE W HDTV 2BE - 30W
o DTV SPORT

[C I Ta S A U XTI fd

Click on WebTV and a new window should appear.

BoxControl o webrv

B 2 131 of 171 min

Search for senvice

13,00 E HOT BIRD

HRT-TW1

227 Ber traga 7, sexija (12) (8/24) {R)
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SLO-TV3

TV K-C
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SAHARL
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e i 1,

The window is somewhat limited in Firefox, as the lower part is "chopped of f* a bit,
sometimes. In that case, the controls are barely visible - but usable! One must choose a group
and then channel to stream (to PC from F500HD).

DOreernbox WebControl thd
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sz -

T
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11) Appendix

"Basic info”: what is Card Sharing?
Card Sharing is:
connecting your receiver with CS capable SW in it [E2 + CS SW, like OSCam or, CCcam]
with your friends' receivers or PCs ["servers"].

Your friends ["peers"] will have Original Smart Cards [OSCs] or Emulators you do NOT have.
You connect with them via the internet in order to watch the programs those OSCs/EMU's
can open.

With CS you have those cards, too - if "only” virtually. But you can still watch the programs
those OSCs/EMU's can open, provided your friends are constantly "online" and you can
connect to their receivers or PCs and the connection is fairly fast and stable.

Create a free DynDNS account

Why? Most IP addresses are dynamic, i.e. they change periodically. This is the way to
connect, regardless of the fact that your IP addresses may change.

Go to https://www.dyndns.com/account/entrance/ and then...

-choose a username

-then a password

-confirm it

-provide them with a valid email [you must!]

-confirm it

-security image - carefully put it in the box provided

-click on "I agree with Terms & conditions"

-click on "Create account".

-You get an email.

-Click on the link provided fo activate the account.

-Login at the dyndns.org website.

-Go to: My Service > Add hostname - create it: xyz.dyndns.org or something else you
choose there [they have a few].

-Click on "Use auto detected IP address xx.xxx.xxx.xx".

-"Add To Cart" - it will say something like "You must checkout to activate”.

-Click on "Next" and then on

-"Activate Service".

-You should see: "Host Services successfully activated”. Now you are ready for the CS part...

GBox [and the SSSP derivatives, like MGcamd and Mbox, for instance], need this to function,
for both Client and Server services. If you only use CCcam client service, it is not needed.


https://www.dyndns.com/account/entrance/
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Log into your DynDNS account [on their website], once a week, so they don't delete your
account. Sometimes they do it, without any notice! Then, you must repeat the procedure.

Let me also mention that there are other similar, gratis services! Just search on the net!
Setup your router/modem with DynDNS details!

After that put the DynDNS details into your Router to enable your DynDNS Service updater
in it, so DynDNS Service is updated every time you change your IP address and your friends
can find you through the DynDNS address. Namely, in your router's DDNS options [if you
have more than one]:

choose DynDNS, then >

put your newly created DynDNS account username, then

DynDNS account password, then

Hostname [like myname.dyndns.org - this is just an example, create your own namell]

How does one get into one's router? Using your browser [like Firefox], of course. You will
see the router's interface after writing http://192.168.x.x or so, into the address field of
your browser, then your router's username and password, which details you will find in the
router's documentation.

That address, i.e. the DynDNS hostname you just created is always going to be the same,
even though your IP address might change every time you logon/get online/boot your PC.

Now SAVE all that, APPLY, or ENABLE, whatever is in your Router's interface, so you do not
lose all those settings.

Now, to port forwarding!

After that, you need to forward some ports in your Router. That allows your CS SW to go
to the net and connect with other PCs, in this case a Server with your friends' cards, the
stuff you want to watch...

Btw, usually many different people end up in the network, so all kinds of packages can be
seenlll In other words, opening up of various ports enables you to get into the dark, pirate
world - but of vivid colours, nevertheless and all that through those little backdoors, called
ports heheeeeee...

This will devilishly keep you busy for a while, you'll see...

Yet more details regarding the router setup

All manner of documents for various routers and modems (so no one will fail in sorting it all
out for themselves), can be seen on the net:

http://www.portforward.com/ - some details to learn about, i.e.
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http://www.portforward.com/routers.htm - routers

Whatever you'll see here might not correspond to your own machine but the principles
explained here will apply, for minimally intelligent people, at least - given the absence of
heavy-duty spiritual laziness!

For more details, have a look at your router's documentation.

So, let's explain the principle of Port Forwarding (opening of ports for traffic, directing it
to a specific device in your home network).

In my modem, it's under Applications and Gaming = Port Range Forwarding. Please, see the
image attached for a better idea...

Now, name an “application” [either by your peer's nickname, because usually you will open
more than just one or two ports for CS, then each could be named after your friend or by
protocol, like Newcamd] - see the image below.

DIR-615 SETUP | ADVANCED | TOOLS STATUS | SUPPORT

Helpful Hints...

- I Chieck
PORT FORWARDING This option i used to open multiple ports or a range of ports in your router and redirect data A R Mpl'catm"

through those ports to a single PC on your network. This feature allows you to enter ports in
various formats incuding, Port Ranges (100-150), Individual Ports (80, 68, 888), or Mixed
{1020-5000, 689).

[Saues:lmgs [M'ILSJHESEMJ

24 -- PORT FORWARDING RULES

Ports to Open
Name = TCP Schedule
_ (Ceam [d(] Application Name - Always
= adit
IP Address uoP Inbound Filter
WI-F1 PROTECTED 192. 165, I Computer Name  ~ I Alow All »
SETLP
Name - TCP Schedule
ADVANCED NETWORK _ Newcamd Applicaion Name  ~ [N Alnays v
J
1P Address uoP Inbound Filter
192,152 NN <<| ComputerName ~ [N Alow Al -

Put the Port Range as follows:

-your port [the one you have to give to your friend to put into his cwsahre.cfg or peer.cfg,
together with your DynDNS and Pass] and

-his port - the one he gave you, where you will be let into his machine, just do the same as
above but name it after your friend, so you know which one is which.
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From experience, it is easier to forward the same port your friend opened for you, as there
is no chance you can swap them by mistake... In that case, the same port should be in Start
and End little box, then

-UDP or Both Protocols, depending on the CS SW protocol, and

-add your IP address, plus tick it at the end, so it is active. {At least, that is how it is in
mine.}

Check your PC's IP address by clicking on the Network Icon in the Systray - depending
on the OS you have, this is OS-specific... Occasionally, it may change, if you get another
device connected to the network, so check it, if CS SW is not working. It looks normally
something like 192.168.1.101 or so.

One can check it also by going to Start > My Network Places > View Network Connections
>click on the active icon > the details are in the lower left hand corner. That is, check your
F500 HD's IP address as described above...

Now, go to the bottom or top of the page (depending on the modem/router) and SAVE/APPLY
SETTINGS! If you did it the right way, it should all be saved and you will see it the way you
want it to be, right in front of you.

More on CS below, when I'll be writing about specific CS SW in detail, with all the juicy stuff
included, like which files exactly and how to edit it etc.

Open Source CamD: OSCaml!!

Forum is here: http://www.oscam.to/wbb3/index.php?page=Index & more help here:
http://www.streamboard.tv/oscam/

Info here: http://www.streamboard.tv/svn/oscam/trunk/Distribution/doc/txt/

Examples: http://www.streamboard.tv/svn/oscam/trunk/Distribution/doc/example/

Latest OSCam for E2 is here: http://download.oscam.cc/index.php

Here's an example for setting it all up:
http://streamboard.gmc.to/wiki/index.php/OSCam/en/examples/Sky HD and MTV-
Unlimited

Many Original SmartCards details here: http://www.streamboard.tv/oscam/wiki/CardsList

A must infois here: http://www.streamboard.tv/wiki/OSCam/en - in 4 major languages.

Thanx, for helping me out while trying to get my head round OSCam, goes primarily fo B@mbi
but also hperez, gianni, subnixonfire, Siri, belami etc. efc.


http://www.oscam.to/wbb3/index.php?page=Index
http://www.streamboard.tv/oscam/
http://www.streamboard.tv/svn/oscam/trunk/Distribution/doc/txt/
http://www.streamboard.tv/svn/oscam/trunk/Distribution/doc/example/
http://download.oscam.cc/index.php
http://streamboard.gmc.to/wiki/index.php/OSCam/en/examples/Sky_HD_and_MTV-Unlimited
http://streamboard.gmc.to/wiki/index.php/OSCam/en/examples/Sky_HD_and_MTV-Unlimited
http://www.streamboard.tv/oscam/wiki/CardsList
http://www.streamboard.tv/wiki/OSCam/en
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I have tested it with my Conax CD card CAS5, as I have already written above. OSCam works
both as a (Newcamd) card reader/server, as well as a (CCcam) client, so there's no need
for any other CS SW.

But if you need an emulator which will also work with keys, use CCcam or MGcamd! Some
people might want BISS or Viaccess encrypted but hacked channels opened by an emulator,
rather than CS SW, as it is faster and more stable. I hear modded OSCam is OK for it, too...

Which version to use?

After plenty of testing, with many different configurations, on a few OSs (original FWs and
E2s), a few original FWs (AZboxHD and Alien2), as well as few versions of E2 (based on DMM
or OpenPLi) - T will try to explain the very basics of OSCam structure. I.e. how it functions,
its basis, in addition to what I have already written.

The version of OSCam I am using, fairly successfully (with a few stops between encrypted
TV programmes, occasionally), is OSCAM 1.10rc-svn build #5775, with dvbapi.

Install it
A little recap: I have described above how to install it from PB support server.

But I have also mentioned how to do it manually. One has to create various files on one's PC,
using a freeware application Notepad++. You will FTP those files by FZC to various folders,
as indicated above. The OSCam module itself, as well as the OSCam script must be "given
rights”, i.,e. CHMOD to 755. Reboot.

Essential files

So, you have the three main configuration files when you install them from PB Centre. They
will appear after you install the configuration package for OSCam (slot 1 or 2). Do not deviate
(a lot) from the ones that you will get like that, for starters, since one wrong parameter
might mean a lot of headache and no pretty pictures on telly... Later, try different ones but
always make a backup BEFORE you attempt any changes! Just in case, for Devil never sleeps!

Those are: oscam.conf, oscam.server, oscam.user. See what they look like above, please.
How OSCam works?

I shall try to explain the best I can, in simple terms, using the least possible jargon, "what
makes OSCam go". Starting from the name of a file...

In oscam.conf file we set up the general configuration/settings for your CS SW.

In global section general settings are sorted out: whether you want logging to go on inside E2
or not, if OSCam should first look to the internet or your local card(s) for info, whether to
spread the load on a number of your peers' cards, so as not to overwhelm a single card etc.
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In webif section (look above - enlarge the image, if needed) one sorts out how to oversee
OSCam at work. Namely, if one can connect to OSCam via a Web Browser to see all the info,
as it's happening, enter the files, even edit them etc. You setup the port, username/password
for it, from where can one connect to OSCam, speed at which the info should be renewed etc.
In WebBrowser one writes: http://192.168.x.x = your box's IP address—> hit the Enter button
on your keyboard. In your Web Browser, if needed, put in the username and password and see
it all happening...

The dvbapi section is used to make OSCam an independent CS SW, not needing any other CS
SW, if one enables it here. One also (dis)allows AU (auto-update of your OSC, i. e. renewal of
your subscription through your [internal] reader), sets up a user (to be used in oscam.user
file) and the boxtype.

If one disables it, then one needs another CS SW to do the decoding, like, for instance,
CCcam. In that case, one can also use all the publicly available keys to open various hacked
channels/providers, using the hacked systems of encryption.

In newcamd section one sets up the key which encrypts the traffic between you and the
peer, port and CAID of your subscription card/provider.

In cccam section one does generally the same thing.

In oscam.server file we set up our local card reader/server (card reader of our “local” card
[or cards]) and external servers (“readers”) of our friends ("peers”). For us, our card is a
“real"/"local" card, whereas their cards are “virtual”.


http://192.168.x.x/
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So, the first [reader] on the list is your [internal/embedded or USB] card reader, the
"server" primarily for yourself, to which the OSCam client part hooks onto, internally, to
open the channels. But it is also a server to your peers/colleagues.

All the following ones are external [readers]. They are also servers but they are the servers
of your peers, to which you hook onto, as a client. ILe. their readers read their cards, not
just for themselves, but for you, too.

Hence, all the readers/servers are simply "readers", whether local [yours] or remote
[virtual, via internet].

The details marked in bold (xx), in those files I posted earlier, you get from your
colleagues/peers, like username, password, port and dyndns domain name. Those are
necessary to hook onto their servers. They must open the port for you at their end.

You as a client in CCcam protocol do not need to open various ports, only servers [your
colleagues/"peers" giving you access to their cards] need to do that.

For now, let's just say that your embedded cardreader/internal reader/server should be in
Group 1, whereas your CCcam external readers should be in Group 2. If you have many C lines
you can sub-divide them further, to make it all better optimised/efficient. Or you can add
Newcamd ones in Group 3, 6Box ones in Group 4 etc. efc.

In the file called oscam.user you are setting/hooking up various "users/clients" to your
"server/reader".

Each "user" in the file has an "account" with your server/reader. I.e. a user will use your
server/services, whether internally [the first one is you, hooking/connecting with your own
card reader/server, inside the receiver itself] or externally [your peers will hook onto your
card viainternet].

Speaking from your peers' standpoint (externally), you allow your peers access to your
server right here, by sefting up their username and password. That's the first part.

The other part, to allow them access to your server, with which you create C (for your CCcam
clients) or N (for your Newcamd clients) lines for your peers/colleagues, is from oscam.conf
file, which we have already explained above.

Divide and control
You can divide the readers and accounts into groups and connect them as you wish.
For instance, your own internal server [the first “reader"] is in group 1.

All the other "readers" of a certain protocol are in group 2. The next protocol goes to
group 3 and the next one to Group 4 etc.
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The very first "account”, i.e. "user" has to be in all the groups [for instance, 1,2,3,4],
in order to hook both onto your own [internal] server/reader, as well as your colleague's
[external] readers/servers.

So, this first user [which is yourself] must hook onto both your internal reader/server
[group 1], as well as external readers [groups 2, 3, 4 etc.].

The other users/accounts are, in my case, Newcamd protocol clients of mine [me being a
server, passing my smartcard to them via N-line], i.e. they are getting access solely to my
smartcard [internal] reader/server, by being placed in Group 1. That way they will not draw
from anything except my smartcard/reader.

Apparently, Newcamd server is meant for this purpose, so this is how it is supposed to be
used. The N-lines you [partially] create from this file [oscam.user] and [partially] from
Newcamd part of oscam.conf file, are to be given to your colleagues, people you trust. With
those lines you pass only your card and nothing else and this is how it is done. These users are
connected to my internal reader/server via Group 1 and thereby not connected to the CCcam
protocol, which busy traffic is placed in Group 2.

This is enough for you to be both a [Newcamd protocol] server, as well as [mainly
CCcam] client. You give your card[s] in return for other people's cards. No need to pay
for "CS services", run by “our” little CS “entrepreneurs”, spoiling the fun for us!ll

How to create N and C lines
Thanx to B@mbil And I quote (my translation):
N-lines:

As explained above, one partially forms an N-line, in oscam. conf file:

[newcamd]
port = AAAAA@xxxx:000000
key = 0102030405060708091011121314

Ergo, N-lines are usually (in Cccam, for instance) made like so:
N: your.dyndns.org AAAAA usernamel passwordl 0102030405060708091011121314

You must add a user with those details to your oscam.user configuration file, using the
specified usernamel and password 1.

AAAAA is the port for your NewCamd server in OSCam and it must be
opened/directed/forwarded in your router, towards your receiver's IP address.

xxxx = CAID for your OSC

key (0102030405060708091011121314) is used to encrypt the connection between two peers
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C-lines:
They usually (in CCcam) look like this:
C: your.dyndns.org BBBBB username2 password2 no

In OSCam, one makes a C-line partially by using the parameters from oscam. conf file's
cccam section (as a connection with remote card-readers):

[cccam]
port = BBBBB

Inyour oscam. user file add a user with username2 & password2 (see the earlier example).

So, BBBBB is a port for your CCcam server in OSCam and it has to be
opened/directed/forwarded in your modem/router towards your receivers IP-address.

Protect your card from misuse by sociopaths
One thing, though: read more about anti-cascading, to prevent misuse of your OSC by others!

http://www.streamboard.tv/wiki/OSCam/en/Config/oscam.conf#Anticasc

http://www.streamboard.tv/svn/oscam/trunk/Distribution/doc/txt/oscam.ac.txt

Here is an explanation, thanx to the sharer whose nick escapes me, sorry... My edit, only...
"Stop your cards being stolen by OSCam users who are faking it.."

This is a quick "how 0" for those of you who want to protect your local card after the recent
rise of card fakers/thieves.

With OSCam currently, users can take a C-line that you have given them and put it into
OSCam, thus bypassing any reshare limits you set. They can then go one step further and
fake your "local” with the 256 trick in CCcam versions prior to 2.1.4. It's nice and easy to use
and just some settings to add.

Anticascading

So if you have a peer who is doing re-sharing/"“faking" he has your card as his own, do this: in
your oscam config directory create a file oscam.ac and put in it:

#

# anti-cascading table

#

# format: <CAID>:<provider ID>=<seconds>

Here is an example for Sly Italia. Follow the format above:



http://www.streamboard.tv/wiki/OSCam/en/Config/oscam.conf#Anticasc
http://www.streamboard.tv/svn/oscam/trunk/Distribution/doc/txt/oscam.ac.txt
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093B:000000 =9
*=15

Next, in your oscam.conf add following:

[anticasc]

enabled = 1

numusers = 1

sampletime = 2

samples = 5

penalty = 0

aclogfile = /var/log/oscam_ac.log
denysamples = 9

fakedelay = 1000

In oscam.user add the following for each guilty user:

penalty = 1

This will work as follows: OSCam will sample every user for ecm requests for 15 minutes.
If a bad, bad guy exceeds the limit OSCam will send a fake CW for the next 9 samples.

If in user file you do...

penalty = 0

...The user will not be punished but it will be logged in aclog file.

Do not go too tight with the settings as people change channels and create additional ECM
requests. Above settings works a treat.

12) In conclusion

This is a great piece of SW, written by great guys, starting from the best values Humanity
has to offerlll Sit down, learn a bit and then...

...enjoy!

KYPYEME
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(..it says "No peace, no pussy! © )
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